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PROJETO 1 – Mapa de Setores Censitários de Recife 

Objetivo: Elaborar um layout com dois Map Frame, um com a classificação dos setores 

censitários do município de Recife em coordenadas planas (Map Frame Principal) e o 

outro com a localização de Recife no conjunto de municípios de Pernambuco e dentro do 

Nordeste (Map Frame Localização), utilizando o ArcGIS Pro.  

A Figura 1, a seguir, mostra o layout a ser elaborado ao término deste Projeto. 

Figura 1: Layout produto deste Projeto: Mapa Setores Censitários.  

 

 

Observações importantes: 

➔ Os arquivos não são salvos automaticamente, então trabalhe salvando o seu 

projeto sempre. 

➔ Operações de geoprocessamento a serem executadas: Recorte e projeção das 

camadas de setores censitários do município escolhido. 

➔ Fonte de dados: IBGE –  Baixar os arquivos do Portal de Mapas do IBGE, 

disponível em: https://portaldemapas.ibge.gov.br/portal.php#homepage 

Para obter os dados que serão utilizados nesse projeto, no canto esquerdo do site o usuário 

deverá selecionar as malhas abaixo, escolha as malhas para o ano mais recente disponível: 

● PE_Setores_2021: 

 

○ Recortes para fins estatísticos > Malha de setores censitários > 2021 (ano 

mais recente) > UFs > Pernambuco – Setores Censitários 2021 

(SHP/KML). 

https://portaldemapas.ibge.gov.br/portal.php#homepage
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● BR_UF_2022: 

 

○ Organização do território > Malhas territoriais > Malha de unidade da 

Federação > Malha com todas as UFs > Brasil - Unidades da Federação 

2022 (SHP). 

 

● PE_Munícipios_2022: 

 

○ Organização do território > Malhas territoriais > Malha de Municípios > 

Pernambuco - Malha municipal 2022 (SHP). 

Os dados baixados do Portal de Mapas do IBGE estão compactados. O usuário deve 

descompactá-los e copiá-los para um diretório de sua escolha (definir previamente o 

diretório). Salve em caminhos curtos, caminhos sem espaços e caracteres especiais, para 

o programa não ter problema de reconhecer os arquivos. Para isso, você deve criar as 

respectivas pastas no HD do seu computador, exemplo: salvar todos os arquivos 

descompactados dentro da mesma pasta “Cursos_ArcPro” em uma pasta 

“Download_IBGE”.  

Objetiva-se por meio do presente tutorial, apresentar diversas ferramentas e operações 

que podem ser efetuadas no ArcGIS PRO e oportunizar o aprendizado no campo do 

Geoprocessamento. 

Abrindo o ArcGIS Pro 

Após abrir o ArcGIS Pro, o usuário deve escolher a opção Start without a Template 

(começar sem um modelo):  

 Figura 2: Começando com o ArcGIS PRO 

 

Criando um projeto novo 

Para iniciar um Novo Projeto no ArcGIS Pro, o usuário deve criar um projeto do zero 

clicando em Ctrl+N, conforme a Figura 3. 
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 Figura 3: Criando um projeto novo 

 

Na janela que aparece crie um novo projeto, dentro de Documentos crie uma nova pasta 

como “D:\\Cursos_ArcPro”, nomeie este projeto de IBGE_SetoresCenso. 

Observação: Caso apareça a aba “Save changes to Untitled?”, clique em não salvar. 

Figura 4: Criando um novo projeto 

 

Quando o usuário cria um projeto no ArcGIS Pro, a opção de criar um folder para o 

projeto está marcada. Dentro do folder criado será armazenado dois arquivos com mesmo 

nome do projeto com a extensão. Gdb (geodatabase ou banco de dados geográficos) e o 

outro com tbx > (caixa de ferramenta). 

Após a criação do projeto, a seguinte tela aparece (View > Catalog Pane): 

 Figura 5: Visualizando o catálogo em aba e caixa 
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Feche a Guia Catalog que está ativa (tarja azul). Verifique que a tela aparece da seguinte 

forma: 

Figura 6: Caixa de Catálogo e visualização da tela 

 

 

OBS: se estiver aberta a aba “Geoprocessamento”, feche-a para visualizar como está 

na imagem acima. 

Expanda a guia Folders(Pastas) na guia Catalog(Catálogo) e verifique os arquivos (.gdb 

e .tbx) que estão dentro da pasta IBGE_SetoresCenso. 

Figura 7: Visualização do gdb e tbx, na caixa de catálogo 

 

Importando Features classes para o GDB 

Expanda a guia Databases(Banco de dados) dentro do Catalog(Catálogo) 

Clique com o botão direito do mouse sobre o IBGE_SetoresCenso.gdb 

Escolha Import > Feature Class(es) 
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Figura 8: Importando as camadas 

 

Importe todos os arquivos que foram baixados do Portal de Mapas do IBGE, disponíveis 

na pasta D:\Cursos_ArcPro\Download_IBGE (ou seja, salvar todos os arquivos 

dentro da mesma pasta “Cursos_ArcPro”). 

OBS: caso não apareça a pasta “Download_IBGE” dentro de “Cursos_ArcPro”, dar 

Refresh no canto superior direito, como na figura abaixo: 

Figura 9: Refresh 

 

Abrir a janela de GEOPROCESSING/GEOPROCESSAMENTO, clique na pasta    

referente a INPUT FEATURES/FEIÇÕES DE ENTRADA para escolher o arquivo que 

irá importar, informe o caminho onde se encontram os arquivos e execute a ferramenta 

de importação. 

Figura 10: Importando as camadas. 
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Figura 11: Selecionando as camadas a serem importadas. 

 

Escolha todos os arquivos SHP que foram baixados no início do projeto, e clique em 

RUN/EXECUTAR no canto inferior direito. 

Feche a aba “Geoprocessing” e verifique que dentro do IBGE_SetoresCenso.gdb foram 

importados os feature class(es). 

Figura 12: Camadas importadas para o gdb 

 

 

OBS: caso também não apareçam os arquivos importados em IBGE_SetoresCenso, 

dar REFRESH novamente. Sempre dê refresh caso algo não apareça de imediato. 

Também é importante ir salvando o projeto à medida em que segue as etapas. 

Exibindo os arquivos no mapa 

Para exibir seus arquivos (feature classes) no mapa: Abrir a guia Insert > New Map. 

Figura 13: Visualização da tela do ArcGIS PRO 
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Clique sobre os feature classes, na guia Catalog/Catálogo, que deseja exibir no mapa e 

com o botão shift pressionado e arraste até a aba Contents Pane (painel de conteúdo), 

no lado esquerdo. 

Figura 14: Selecionando as camadas para inclusão no Mapa (Map) 

 

Para facilitar a navegação, você pode desmarcar os mapas que foram adicionados ao criar 

um mapa. 

Realizando operações de geoprocessamento (selecionado uma feição e exportando 

para o GDB) 

Como foi solicitado dois Map Frame, será necessário criar dois mapas. Um como os 

setores censitários em coordenadas UTM (mapa principal) e o outro em coordenadas 

geográficas (mapa de localização). 

Os dados baixados do IBGE estão com referência espacial em SIRGAS2000 em 

coordenadas geográficas. Para saber essa informação é só clicar com botão direito do 

mouse sobre a camada que deseja consultar e escolher: Properties > Source > Espatial 

Reference. 

Inicialmente, faremos a seleção do município de Recife e sobre ele o recorte dos setores 

censitários. 

Para isso, no canto superior na aba Map, vá em Selection e escolha Select by Atributes. 

Figura 15: Aba Map e suas opções 

 

Crie uma expressão para selecionar o município de Recife dentro do conjunto de 

municípios de Pernambuco, como mostra na imagem abaixo.  

A coluna da tabela de atributos da camada PE_municipios_2022 que contém o nome do 

município é NM_MUN. 
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Figura 16: Selecionando por atributos o município de Recife 

 

Execute a ferramenta de consulta por atributos (Run). 

Em seguida, com o município Recife selecionado nesta camada em Contents, clique com 

o botão direito do mouse na camada e escolha Data > Export Features e exporte essa 

feição do tipo polígono para dentro do gdb. 

Figura 17: Exportando a camada com o município de Recife 

 

Verifique que o BDG terá um novo feature class (Recife). Na Contents Pane/Painel de 

conteúdo também será adicionado o feature class obtido. 

Lembre-se: A cada mudança feita, aperte com o botão direito em cima da camada 

alterada e aplique o “refresh” para sua atualização.  
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Figura 18: Visualização da camada 

 

Realizando operações de geoprocessamento (Recortando camada e reprojetando) 

O mapa de setores censitários de Pernambuco deve ser recortado pelo polígono do Recife, 

afinal o que se quer é a classificação dos setores censitários deste município. Na verdade, 

queremos saber em que parte do município temos áreas urbana ou rural, de alta ou baixa 

densidade de edificações, etc. 

Neste caso, realizaremos um clipping, que é um recorte. 

Vá em Analysis > Tools e na caixa de pesquisa que aparece na guia Geoprocessing 

escreva Clip. 

Figura 19: Analysis Tools 

 

Na janela que aparece preencha conforme apresentado na figura que segue. Qualquer 

dúvida em selecionar os arquivos, passe o mouse sobre o nome do arquivo que aparecerá 

o ícone de informação ao lado. 

Figura 20: Recortando a camada 

 

Lembre-se que esta operação resultará em um novo feature class que será salvo no GDB 

do seu projeto. Escolha nomear Recife_Setores em “Classe de feição de saída”. 
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Execute a ferramenta. 

Observe o GDB no Catalog Pane/Painel de catálogo e, também, na Contents 

Pane/Painel de Conteúdo. Deve estar como na imagem abaixo. 

Figura 21: Camada recortada e tela do ArcGIS PRO 

 
  

Será necessário reprojetar a camada Recife e Recife_Setores para o sistema de 

coordenadas UTM Fuso 25 Datum Sirgas2000. 

Antes disso, deve ser criado um Feature dataset (conjunto de feature classes), pois no 

mesmo GDB não é possível unir camadas com referências espaciais diferentes. 

Para isso, vá no seu GDB (IBGE_SetoresCenso.gdb) no Catalog Pane e com o botão 

direito do mouse escolha New > Feature Dataset (conjunto de dados de feição). 

Figura 22: Seleção para dados de feição 

 

Preencha a janela com os dados necessários. No nome do feature dataset, escolha UTM. 

No sistema de coordenada, escolha Projected Coordinate System (sistema de 

coordenadas planas), conforme a figura que segue. 
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Figura 23: Sistema de coordenadas para fins de seleção 

  

Em seguida aponte para UTM> South American> SIRGAS 2000 > SIRGAS 2000 

UTM Zone 25S. 

Figura 24: Sistema de coordenada selecionado 

 

Execute a ferramenta. 

Observe no GDB que foi criado um Feature Dataset chamado UTM. 

Figura 25: Conjunto de dados em UTM 

 

Após criação do Feature Dataset com referência espacial em UTM Fuso 25 em 

Sirgas2000, será possível reprojetar as duas camadas (Recife e Recife_Setores) para esta 

referência, sendo salvo no mesmo GDB. 

Para isso, da mesma forma deverá escolher Analysis > Tools e escrever na barra de 

pesquisa project. Nas opções que aparecem, como precisamos reprojetar mais de um 

arquivo, escolha Bath Project (Projetar em Lote). 

Na janela que aparece preencha conforme apresentado na figura que segue.  

OBS: em “Input Feature Class or Dataset”, dar enter depois de colocar “Recife” para 

poder adicionar “Recife_Setores”. 

Figura 26: Projetando o lote de dados 
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Observe que o BDG foi atualizado e incluiu os dois arquivos reprojetados, dentro do 

Dataset “UTM”. Observe que também foi adicionado ao mapa as duas camadas obtidas. 

Figura 27: Camadas obtidas no mapa 

 

 

Na aba “Catálogo” , expanda UTM, renomeie os feature classes Recife_1 e 

Recife_Setores_1 para Recife_UTM e Recife_Setores_UTM, respectivamente. 

Observe que os feature classes reprojetados não foram adicionados no mapa na Contents 

Pane. 

Para renomear, na Catalog Pane clique com o botão direito do mouse sobre as camadas 

que deseja alterar os nomes e escolha Rename. 

Você também pode alterar o nome do mapa que foi criado com todas as camadas 

adicionadas da mesma forma que fez para os feature classes. Renomeie o mapa trabalhado 

para GEO, já que todas as camadas adicionadas/ trabalhadas estão em coordenadas 

geográficas. Escolha no Catalog Pane > Map > Rename, como está na imagem abaixo.  

OBS: diferente da imagem, aqui ainda não deve aparecer “UTM” embaixo, só 

deverá ter um mapa, nomeado originalmente “Map”. 
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Figura 28: Mapas renomeados 

 

Adicionando novo mapa ao projeto 

Para adicionar um novo mapa ao projeto, selecione Insert > New Map.  

Esse novo mapa receberá as camadas reprojetadas para UTM fuso 25 em Sirgas2000.  

Desta forma, a partir do Catalog Pane, selecione e arraste as camadas 

Recife_Setores_UTM e Recife_UTM para o Contents Pane. 

Obs. Se a camada Recife_Setores_UTM ao ser arrastada retorna ao nome anterior 

(Recife_Setores_1), renomeie novamente clicando com o botão direito sobre a camada e 

indo em Propriedades. 

Renomeie este novo mapa para UTM, seguindo o mesmo processo que fez para renomear 

“GEO”. 

Fazendo modificações na simbologia das camadas 

No mapa UTM e no mapa GEO, faremos modificação na simbologia das camadas. 

Inicialmente, no mapa UTM, selecione a simbologia da camada Recife_UTM (clicar em 

cima do quadrado colorido que está abaixo de “Recife_UTM”, ou seja, sua 

simbologia). 

Deixe-a com uma linha tracejada e cor vermelha, seguindo a imagem abaixo. 

OBS: em “Gallery”, selecione o tracejado e em “Properties" selecione a cor desejada. 
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Figura 29: Simbologia da camada “Recife_UTM”

 

OBS: caso o tracejado não apareça de imediato, tente dar refresh e desabilite 

algumas camadas, nesse caso a camada World Hillshade, para facilitar a 

visualização das alterações. 

Da mesma forma, clique sobre a simbologia da camada Recife_Setores_UTM. Neste 

caso, mudaremos a simbologia primária da camada, então na janela que aparece, clique 

na seta para voltar uma janela. 

Figura 30: Edição da simbologia 

 

 

Feito isso, a seguinte janela aparece: 
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Figura 31 Edição da simbologia 2 

 

Em Primary Symbolize(Simbologia Primária), escolha Symbolize your layer by 

category > Unique Values. 

Figura 32: Edição da simbologia 3 

 

Na janela que aparece, escolha o campo/coluna NM_SIT para por ele ser categorizada a 

camada, conforme mostra a figura. Também escolha uma paleta de cor para apresentar o 

resultado. 
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Figura 33: Edição da simbologia 4 

 

Se as cores apresentadas pelos tipos de setores censitários de Recife não forem 

satisfatórias, você pode mudar clicando duas vezes sobre cada simbologia e escolher a 

cor que deseja. 

OBS: para eliminar uma determinada categoria, você deve clicar com botão direito 

sobre a categoria que quer remover e escolher Remove. Faça isso para a categoria  

All others values. 

Figura 34: Edição da simbologia 5 

 

Foram realizadas mudanças na simbologia desta camada e agora se apresenta assim: 
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Figura 35: Mapa principal do projeto 

 

Este é o mapa principal do projeto. Lembrando que o objetivo final é configurar um layout 

com dois Map Frame (principal com camadas em Geográficas e outro em coordenadas 

planas UTM). 

Agora vamos realizar mudanças na simbologia das outras camadas que estão em 

coordenadas geográficas. 

Deixe o mapa GEO ativo(clicando duas vezes sobre ele em Catalog). Copie e cole a 

camada Recife_UTM, configurada anteriormente no mapa UTM, para Contents Pane 

do mapa GEO. Para isso, é só clicar sobre a camada com o botão direito e escolher Copy. 

Ao levá-la para o outro mapa, clique com o botão direito do mouse sobre o título do mapa 

e escolha Paste. 

Remova Recife e Recife_setores desse mapa (GEO), clicando o botão direito e 

selecionando "Remove”, e renomeie as camadas PE_Municipios_2022 para Municípios 

de Pernambuco e BR_UF_2022 para Estados do Brasil. 

OBS: para renomear, clicar em cima da camada em Contents e renomear. 

Renomear no Catalog somente com underline. 

Faça alteração na simbologia da camada Municípios de Pernambuco, deixando-o na cor 

branca e linhas na cor preta. 
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Figura 36: Alteração da simbologia na camada Munícipios de Pernambuco 

 

 

Para o mapa de localização de Recife, será necessário inserir rótulos com os nomes dos 

Estados do Brasil. Para isso, clique sobre esta camada e escolha na parte superior 

Labeling (Rotulação). 

Figura 37: Rotulação 

 

OBS: Estas opções só aparecem quando a camada permite. 

Feito isso, escolha a coluna pela qual deseja que os rótulos sejam adicionados. Neste caso, 

SIGLA_UF. Para isso, vá em FIELD(CAMPO) no canto superior esquerdo e selecione, 

abrindo a setinha, “SIGLA_UF”. Não se esqueça de clicar em LABEL(RÓTULO) no 

canto superior esquerdo, para salvar e aplicar essas alterações. 

Figura 38: Selecionando o rótulo a ser adicionado 
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Dê um zoom para a camada Municípios de Pernambuco para apresentá-la na tela, clicando 

com botão direito do mouse sobre esta camada e escolhendo a opção Zoom to layer. 

Como Fernando de Noronha pertence a Pernambuco, no Zoom to layer a visão é esta! 

Figura 39: Visualização da camada com zoom 

 

 

Criando um layout 

Inicialmente, devemos criar o Map Frame principal do layout, que conterá o mapa em 

coordenadas planas.  

Para criar um layout, escolha INSERT > NEW LAYOUT. A formatação do papel para 

esse projeto pode ser feita em A4 ou A1 em formato paisagem.  

Ainda em INSERT, na aba aberta de Layout, escolha MAP FRAME (Estrutura do 

Mapa). Observe que aparecem as duas opções de mapa que foram feitas (GEO e UTM). 

OBS: O Map Frame vai mostrar a forma como você deixou aberta a visualização, 

seja na aba GEO ou UTM, sendo nesse caso primeiramente UTM. Ou seja, se não 

estiver da forma como você deseja é só dar zoom e reposicionar na aba GEO ou 

UTM. 
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Figura 40: Escolhendo UTM para layout 

 

Escolha o UTM que será o Map Frame principal, conforme mencionado antes. 

Ao fazer essa escolha, você deverá selecionar a área do mapa na qual será elaborado o 

Map Frame. 

Figura 41: Montando o layout 1 

 

Ao ativar o Map Frame que foi adicionado, é possível formatá-lo. 

Observe que é possível alterar o nome do Map Frame. Acrescente a palavra “principal” 

ao nome do Map Frame. Para fazer isso, clique com botão direito em Map Frame 

(Estrutura do Mapa) em Contents, e depois em Propriedades. 
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Figura 42: Estrutura do mapa principal 

 

Na guia(ícone) posterior, em Location Settings é possível alterar a escala do mapa. Altere 

para 1/200.000. Ainda nesta opção, observe em Units que a referência espacial em 

Metros. As outras opções que estão disponíveis, não precisam ser alteradas, porém é 

importante que observe e conheça a sua finalidade. 

Figura 43: Selecionando a escala do mapa – propriedades da estrutura do mapa. 

 

Observe em Display Options- Constraint que é possível selecionar a restrição 

apropriada. Veja e entenda as opções disponíveis e escolha Fixed scale. 
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Figura 44: Selecionando escala fixa 

 

Feito isso, vamos adicionar elementos ao mapa, a saber: 

Barra de escala, Seta Norte e Legenda. 

Para isso, escolha os ícones disponíveis na barra de opções com o Map Frame principal 

selecionado. Os ícones estão na aba “Insert”. 

Figura 45: Opções de escala, seta e legenda 

 

Ao clicar sobre cada um dos ícones, será aberto o painel de propriedades para que seja 

formatado de acordo com sua preferência. Insira os três elementos e verifique suas 

propriedades. Ao clicar na setinha embaixo de cada ícone, você poderá ver as 

melhores opções e escolher a que mais se adequa (Fazer como na imagem abaixo.) 

Para alterar os nomes exibidos na legenda do Map Frame em UTM, você deverá 

selecionar a camada que deseja em Content em seguida clicar novamente sobre ela. Este 

procedimento dará a opção de editar o nome da camada. 
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Figura 46: Com as setas e legenda 

 

 

Para finalizar o Map Frame Principal é necessário adicionar uma grade de coordenadas 

para facilitar sua leitura e interpretação. 

Para isso, com o Map Frame Principal selecionado, escolha Insert- Grid. 

Figura 47: Incluindo grade de mapa 

  

Escolha a opção Black Vertical Grid na lista que aparece em Measured Grid (Grade 

dimensionada). A grade/ grid é adicionada levando em conta a escala do mapa. Há 

diversos tipos de grid/ quadrículas disponíveis. Navegue e descubra as diferenças entre 

elas. 
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Figura 48: Layout com a grade de mapa 

 

Você pode adicionar o Black Horizontal Grid para observar as diferenças nessas grades. 

Fazendo isso, observe que os labels/ rótulos da grade/ grid passaram por cima da legenda, 

neste caso. Podemos melhorar esta configuração e formatar para que estes inconvenientes 

sejam eliminados. Contudo, deve ser feito assim que a grade for adicionada, na aba aberta 

do lado direito com as opções de formatação. 

Figura 49: Formatando grade de mapa 

 

Caso já tenha inserido a grade e a opção de formatá-la já não esteja disponível, você pode 

diminuir o Map Frame principal e a própria legenda, é mais simples.  

Lembrando que você pode eliminar e adicionar uma nova grade ou qualquer outro 

elemento do mapa ou do layout de forma simples.  

Agora, vamos adicionar o Map Frame de localização de Recife. 
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Da mesma forma que o anterior, em Insert escolha Map Frame e selecione uma das 

opções que aparecem no mapa GEO. Delimite a lateral direita para que o map frame seja 

elaborado. 

Você pode renomear o Map Frame para Map Frame Localização. 

Insira uma grade neste novo Map Frame, seguindo os passos anteriormente apresentados, 

porém escolha a opção Quadricule- Black Vertical Label Quadricule, isso porque o 

Map Frame está em coordenadas geográficas. 

Observe que o layout possui algumas camadas que ainda não estão na legenda, como é o 

caso de Estados do Brasil e Municípios de Pernambuco do Map Frame localização. Isso 

porque a legenda foi elaborada com as camadas do mapa UTM. 

Dessa forma, vamos adicionar estas camadas/ features no Mapa UTM e incluí-las na 

legenda. 

Na Contends Pane copie e cole essas camadas do mapa GEO para o mapa UTM. Clique 

com botão direito do mouse sobre as camadas desejadas no mapa GEO e escolha Copy. 

Em seguida, com o botão direito do mouse sobre o mapa UTM, escolha Paste. 

No Layout selecione Legend ou clique sobre a legenda já feita. Nas configurações 

Synchronize with map, desmarque a opção Layer Visibility. Isso fará com que todos os 

layers/ camadas/ features do mapa estejam inseridos na legenda. 

OBS: caso fique com dois nomes “Legenda”, é só clicar com o botão direito em 

legenda em Contents > Propriedades e apagar o nome. 

Figura 50: Formatando legenda 

 

Para retirar os créditos da Esri que fica no mapa, aperte em View > Layout > Menu 

Insert > Dynamic text > Service Layer Credits. Arraste para fora do mapa os créditos 

selecionados.  

Por fim, insira um texto onde irá fornecer algumas informações importantes do seu layout. 
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Ao finalizar seu layout, poderá salvar em PDF, por exemplo. 

Em Share, escolha Layout. Preencha com as informações necessárias e abra o PDF 

exportado. 

Figura 51: Layout final do projeto 

 

 

Finalizamos a produção do nosso mapa de Setores Censitários. 

Não esqueça!! Antes de fechar o ArcGIS Pro você deve salvar o projeto! 
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PROJETO 2 - Mapa Temático dos Biomas no Brasil com divisão por 

Estados 

Objetivo: Elaborar um layout de mapa temático com dados dos biomas brasileiros 

utilizando o ArcGIS Pro. A Figura 1, a seguir, mostra o layout a ser elaborado ao término 

deste Projeto. 

Figura 1: Layout produto deste Projeto: Mapa dos Biomas Brasileiros a ser criado no projeto 

 

Observações importantes: 

➔ Os arquivos não são salvos automaticamente, então trabalhe salvando o seu 

projeto sempre. 

➔ Operações de geoprocessamento a serem executadas: Recorte e projeção das 

camadas dos biomas brasileiros. 

➔ Fonte de dados: Para obter os dados que serão utilizados nesse projeto, o usuário 

deverá acessar os links abaixo e selecionar os arquivos, escolha as malhas para o 

ano mais recente disponível: 

 

● Biomas: 

○ Link:https://www.ibge.gov.br/geociencias/informacoes-

ambientais/vegetacao/15842-biomas.html?=&t=downloads.  

○  Download > Vetores > Biomas_250mil.zip  

● Unidades de Federação do Brasil:  

○ Link: https://portaldemapas.ibge.gov.br/portal.php#mapa223495.  

https://www.ibge.gov.br/geociencias/informacoes-ambientais/vegetacao/15842-biomas.html?=&t=downloads
https://www.ibge.gov.br/geociencias/informacoes-ambientais/vegetacao/15842-biomas.html?=&t=downloads
https://www.ibge.gov.br/
https://portaldemapas.ibge.gov.br/portal.php#mapa223495
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○ Organização do território > Malhas territoriais > Malha de unidade da 

Federação > Malha com todas as UFs > Brasil - Unidades da Federação 

2022 (SHP). 

 

Os dados baixados do Portal de Mapas do IBGE e IBGE estão compactados. O usuário 

deve descompactá-los e copiá-los para um diretório de sua escolha (definir previamente 

o diretório).Salve em caminhos curtos, caminhos sem espaços e caracteres especiais, para 

o programa não ter problema de reconhecer os arquivos. Para isso, você deve criar as 

respectivas pastas no HD do seu computador, exemplo: salvar todos os arquivos 

descompactados dentro da mesma pasta “Cursos_ArcPro” em uma pasta 

“Download_Dados”.  

Objetiva-se por meio do presente tutorial, apresentar diversas ferramentas e operações 

que podem ser efetuadas no ArcGIS PRO e oportunizar o aprendizado no campo do 

Geoprocessamento. 

Novo Projeto no ArcGIS Pro 

Para iniciar um Novo Projeto no ArcGIS Pro, o usuário deve criar um projeto do zero 

clicando em Ctrl+N, conforme a Figura 3. 

 Figura 2: Criando um projeto novo. 

 

Criando o projeto  

Abra o ArcGIS Pro, inicie um novo projeto clicando em MAP/MAPA, nomeie o projeto 

como Mapa_Biomas_Brasileiros (importante não criar nomes com espaços). Escolha o 

local para salvar o projeto em seu computador e clique em OK. 

 

Figura 3: Como iniciar um novo projeto 
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Observe que na guia CATALOG/CATÁLOGO, expandindo a FOLDERS/PASTAS, 

irá aparecer o GDB criado com o nome do arquivo.  

Figura 4: Exibindo onde está o GDB do arquivo 

 

Adicionando Shapefiles ao GDB 

Vamos importar FEATURES CLASSES/CLASSES DE FEIÇÕES para o GDB inicial. 

Ainda no CATALOG/CATÁLOGO, expanda a guia DATABASES/BANCOS DE 

DADOS. Em seguida, clique com o botão direito em cima do GDB 

Mapa_Biomas_Brasileiros.gdb. Em seguida escolha IMPORT/IMPORTAR e 

FEATURES CLASSES/CLASSES DE FEIÇÕES. 

Figura 5: GDB e criação de FEATURES CLASSES. 

 

 

 

 

 

 

 

Figura 6: Importando FEATURES CLASSES. 

 

 

 

 

 



 

33 
 

Abrir a janela de GEOPROCESSING/GEOPROCESSAMENTO, clique na pasta 

referente a INPUT FEATURES/FEIÇÕES DE ENTRADA para escolher o arquivo que 

irá importar. Escolha todos os arquivos SHP que foram baixados no início do projeto, e 

clique em RUN/EXECUTAR.  

Figura 7: Como importar Features Classes 

 

 

Todos os FEATURES CLASSES/CLASSES DE FEIÇÕES serão inseridos ao GDB. 

Caso não estejam visíveis, clique com botão direito no GDB e escolha 

REFRESH/ATUALIZAR. 

Exibindo os arquivos no mapa 

Para exibir os shapefiles que foram inseridos nos FEATURES CLASSES/CLASSES DE 

FEIÇÕES do GDB, na janela do CATALOG/CATÁLOGO selecione os arquivos e 

arraste para a área do mapa. 

 

Figura 8:  Features classes inseridos no GDB 
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Para alterar o nome das camadas, clique em cima dela, aperte F2 e renomeie 

lm_bioma_250 para BIOMAS e BR_UF_2021 para BRASIL. 

Importante observar a coordenada de suas camadas, neste projeto usaremos coordenada 

geográfica, e por serem dados do Brasil, devem estar em SIRGAS 2000. Para conferir, 

clique com botão direito na camada – PROPERTIES/PROPRIEDADES - 

SOURCE/FONTE – SPATIAL REFERENCE/REFERÊNCIA ESPACIAL, e lá vai 

estar o Sistema de Coordenadas Geográficas da camada, no caso será SIRGAS 2000. 

Figura 9: Conferindo o Sistema de Coordenada da camada 

 

 

Em seguida, é preciso verificar ou definir a coordenada geográfica do projeto, de acordo 

com as camadas. Clique com o botão direito em MAP/MAPA (Na guia Contents) - 

PROPERTIES/PROPRIEDADES – COORDINATE SYSTEMS/SISTEMAS DE 

COORDENADAS. O projeto já estará automaticamente em SIRGAS 2000, pois o 

ArcGIS deixa a coordenada do projeto de acordo com a coordenada do primeiro arquivo 

inserido.  

Figura 10:  Conferindo o Sistema de Coordenadas do Projeto 
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Colorindo e categorizando a camada Biomas 

Abra a tabela de atributos clicando com o botão direito do mouse na camada  vá na opção 

“Open Table”. Observe as categorias que existem na coluna biomas. 

Figura 11: Tabela de Atributos dos Biomas Brasileiros 

 

 

Depois dê dois cliques em cima do quadrado colorido que está abaixo da camada para 

abrir a formatação de simbologia ou no menu clique em APPEARANCE/CAMADA DE 

FEIÇOES – SYMBOLOGY/SIMBOLOGIA. Será aberta a janela 

SYMBOLOGY/SIMBOLOGIA no lado direito da tela.  

Onde estiver SINGLE SYMBOL/SÍMBOLO ÚNICO, mude para UNIQUE 

VALUES/VALORES ÚNICOS, que corresponde a camadas categorizadas com nomes 

e dados numéricos. 

 

Figura 12: Editando a camada Biomas 
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No FIELD 1/CAMPO 1, deixaremos a coluna correspondente na Tabela de Atributos 

que indica e categoriza os Biomas, no caso será BIOMAS. No item COLOR 

SCHEME/ESQUEMA DE CORES, podemos escolher a paleta de cores para a 

categorização, escolha as cores indicadas na imagem abaixo. 

Para as cores serem preenchidas no desenho/camada, clique no ícone ADD ALL 

VALUES/ADICIONAR TODOS OS VALORES ( ). 

Figura 13: Editando as cores das categorias dos Biomas Brasileiros 

 

Editando Mapa - camada BIOMAS 

Ainda na camada BIOMAS, vamos tirar as linhas que separam as cores dos biomas. Na 

tela de simbologia, escolha MORE/MAIS – FORMAT ALL 

SYMBOLS/FORMATAR TODOS OS SÍMBOLOS. 

 

Figura 14: Editando a camada Biomas – Linhas de contorno 

 

Na tela seguinte, clique em PROPERTIES/PROPRIEDADES – OUTLINE 

COLOR/COR DO CONTORNO. Escolha NO COLOR/SEM COR, e clique em 

APPLY/APLICAR. 
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Figura 15:  Editando a camada Biomas – Linhas de contorno 

 

 

Organize as Camadas de acordo com a hierarquia das informações que devem aparecer 

primeiro. Vamos precisar que apareça a divisão dos Estados, para isso puxamos a camada 

BRASIL para ficar acima da camada BIOMAS. As informações editadas dos Biomas irão 

desaparecer, mas vamos agora editar a camada BRASIL para que todas informações 

fiquem visíveis.  

Editando Mapa - camada BRASIL 

Vamos tirar o preenchimento da camada Brasil. Clique no quadrado preenchido da 

camada BRASIL e abra a janela SIMBOLOGY/SIMBOLOGIA. Em 

PROPERTIES/PROPRIEDADES, escolha NO COLOR/SEM COR para retirar o 

preenchimento da camada. Clique em APPLY/APLICAR para exibir a formatação e 

exibir os biomas por Estados. 

 

Figura 16: Editando a camada Brasil – Preenchimento e contornos 
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- Para inserir o nome dos Estados Brasileiros, clique em na camada BRASIL e em seguida 

no LABELING/ROTULAÇÃO (na guia superior). Em seguida escolha NM_UF em 

CAMPO. Os símbolos do texto, como tamanho, fonte e cores, selecione fonte ARIAL, 

tamanho 10, e cor CINZA 70%. Clique em Rótulo para aplicar todos os comandos no 

mapa. 

Figura 17: Inserindo rotulação do nome dos Estados 

 

Inserindo imagem de satélite – Oceano 

Para inserir informações do oceano no nosso mapa, vamos colocar uma imagem de 

satélite. Para isso, vamos clicar na aba/menu MAP/MAPA – BASE MAP/MAPA 

BASE, e escolha o mapa base OCEANS/OCEANOS. O mapa base traz informações 

textuais criando uma camada nomeada como WORLD OCEAN 

REFERENCE/REFERÊNCIA DE OCEANO MUNDIAL, remova essa camada do 

projeto (clicando com o botão direito), pois não vamos precisar desses dados.  

 

Figura 18: Inserindo mapa base – OCEANOS – ao projeto 

 

Criando Layout do Mapa de Biomas Brasileiros 

No menu clique na aba INSERT/INSERIR – NEW LAYOUT/NOVO LAYOUT e 

escolha o formato A3 – PORTRAIT/RETRATO. 
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Figura 19: Escolhendo tamanho da folha do layout 

 

Clique com botão direito sobre a régua na tela de criação do layout, para adicionar 

margens na folha, escolha ADD GUIDERS/ADICIONAR GUIAS.  

Figura 20: Editando as margens do layout 

 

 

Em seguida escolha BOTH/AMBOS(na guia “Orientation”), em 

PLACEMENT/DISPOSIÇÃO escolha OFFSET FROM EDGE/DESLOCAR DA 

EXTREMIDADE. Em MARGIN/MARGEM, insira um afastamento da margem de 

5mm e clique em OK. 

Figura 21: Editando as margens do layout 

 

Para inserir o mapa na tela, escolha MAP FRAME/ESTRUTURA DO MAPA, e 

escolha o mapa que foi construído. 
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Figura 22: Inserindo o mapa no layout 

 

Em seguida, faça o retângulo dentro da margem que foi criada no layout. O mapa será 

inserido na tela.  

Para mover ou alterar o zoom do mapa, clique na aba LAYOUT e em seguida 

ACTIVATE/ATIVAR. Após configurar o mapa na margem, clique que LAYOUT e 

CLOSE ACTIVATION/FECHAR ATIVAÇÃO.  

Figura 23: Mapa inserido no layout 

 

Agora vamos adicionar o GRID/GRADE de Coordenadas. Clique na aba 

INSERT/INSERIR – GRID/GRADE. Escolha uma grade de graus, por estar 

trabalhando em sistema de coordenadas geográficas SIRGAS 2000. Vamos escolher a 

que já coloca a grade lateral na posição vertical. 

Figura 24: Como inserir a grade de coordenadas no projeto 
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Para editar a grade de coordenadas, clique duas vezes na camada GRID/GRADE criada. 

Uma janela de edição irá abrir no lado direito da tela. 

Desabilite a opção AUTOMATICALLY ADJUST/AJUSTAR 

AUTOMATICAMENTE, para poder editar o GRID.  

 

Figura 25: Editando as linhas de grade do projeto 

  

Vamos inicialmente editar os COMPONENTS/COMPONENTES, clicando no ícone 

. Aparecerá para edição os componentes LABELS/RÓTULOS, TICKS 1, TICKS 

e GRID LINES/LINHAS DE GRADE. 

- Vamos editar a margem da grade para a folha do layout no item 

APPEARANCE/APARÊNCIA, deixando um intervalo de 2,5mm.  

- Para diminuir a letra das coordenadas, clique em SYMBOL/SÍMBOLO para editar o 

texto, diminuindo para o tamanho 6. Clique em Apply e volte para editar as outras partes 

do GRID. 

Figura 26: Editando as linhas de grade do projeto - Rótulos 

 

 

 

 

 

 

 

- Para editar os Ticks, precisa saber o que cada um corresponde. Os Ticks 1 são as linhas 

menores da grade que aparecem nas margens. Os Ticks são as linhas maiores da grade de 

coordenadas.  
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Figura 27: Editando as linhas de grade do projeto – Ticks 1 

 

- Para remover os Ticks 1, basta clicar no componente e em seguida no X ao lado da caixa 

de componentes.  

Figura 28: Editando as linhas de grade do projeto – Ticks 1 

 

- Vamos editar o comprimento dos Ticks, clicando sobre o componente e alterando 

LENGTH/COMPRIMENTO, vamos colocar 1mm, para que a linha não fique por cima 

do número da coordenada. 

Figura 29: Editando as linhas de grade do projeto – Ticks 

  

- As linhas dos GRIDS com informações em cima do desenho podem ser retiradas. Para 

isso, vamos escolher o componente GRID LINES/LINHAS DE GRADE, clicar no X, ou 

em SYMBOL/SÍMBOLO escolher NO COLOR.  
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Figura 30: Projeto com linhas de grade de coordenadas x Projeto sem linhas de grade de 

coordenadas 

 

 

Colocando um título no seu mapa, vá em INSERT/INSERIR e em seguida clique na 

opção STRAIGHT TEXT/TEXTO RETO localizada na guia superior em GRAPHICS 

AND TEXTS. Em seguida, faça um retângulo na área do mapa para inserir o título 

BIOMAS BRASILEIROS. Para editar o texto, clique na camada TEXT criada no lado 

esquerdo e na janela do lado direito, altere fonte e o tamanho do texto. 

Figura 31: Inserindo Título ao mapa 

 

- Selecione o MAP FRAME/ESTRUTURA DO MAPA, para inserir a indicação do Norte. 

Clique em INSERT/INSERIR e escolha um NORTE, clique na área do mapa para inserir. 

 

 

 

 



 

44 
 

Figura 32: Inserindo informação do Norte no mapa 

 

 

- Para retirar o texto fonte do Base Map, clique no Map Frame, clique em 

FORMAT/ESTRUTURA DO MAPA e em seguida em DYNAMIC TEXT/TEXTO 

DINÂMICO. Procure pela opção SERVICE LAYER CREDITS/CRÉDITOS DA 

CAMADA DE SERVIÇO. Clique fora da área do mapa, assim o texto que estava no 

mapa irá aparecer nessa nova área.  

Figura 33: Retirando dados de fonte do mapa base 

 

 

 - Para inserir a legenda no mapa, clique e INSERT/INSERIR e em seguida escolha 

LEGEND/LEGENDA. Na área do mapa, clique e forme o retângulo para inserir a 

legenda.  
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Figura 34: Inserindo legenda ao mapa 

 

 

Para destacar a legenda, vamos inserir um retângulo. Clique em INSERT/INSERIR e 

escolha um retângulo. Desenho o retângulo contornando a área da legenda. 

Figura 35: Criando retângulo de destaque para a legenda 

 

 

Em seguida, na edição do retângulo, em SYMBOL, escolha a cor CINZA, e 0,5 para a 

espessura do contorno. Clique em APPLY. Do lado esquerdo, puxe a camada do 

Retângulo para abaixo da camada Legenda, para que possa aparecer as informações da 

legenda.  
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Figura 36: Editando retângulo inserido na legenda ao mapa 

 

 

- Para inserir a informação de escala, clique em MAP FRAME, em seguida INSERT e 

escolha SCALE BAR/BARRA DE ESCALA. Escolha uma escala da barra metros. 

Clique na área do mapa e arraste. A escala trará a informação “quilômetros”, na janela de 

edição do lado direito, em label text, digite KM. 

Inserindo informações no mapa 

Após inserir os dados no layout do mapa, vamos inserir as informações de fonte de dados. 

Clique em INSERT e escolha STRAIGHT TEXT/TEXTO RETO. Clique e arraste na 

área do mapa. Se o texto já aparecer grande, clique em FORMAT e escolha o tamanho 

do texto e cor. Para o mapa de Biomas, escolha o tamanho do texto 13, e cor preta. Insira 

as informações: 

 

FONTE:  

Biomas (IBGE, 2021).  

Base cartográfica limites estaduais (IBGE, 2021). 

 

AUTOR: Insira seu nome 

Data: ___ / ___/ ____. 

 

Sistema de Coordenadas Geográficas 

Datum: SIRGAS 2000. 
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Figura 37: Dados de fontes, autoria e coordenadas inseridos no mapa 

 

Exportando Mapa 

No menu, clique em SHARE/COMPARTILHAR – EXPORT 

LAYOUT/EXPORTAR LAYOUT. Escolha a pasta que deseja guardar o 

arquivo e nomeie o mapa para MAPA BIOMAS BRASILEIROS. Escolha o 

tipo de arquivo para JPEG. E em seguida clique em EXPORT/EXPORTAR. 

Figura 38: Exportando o mapa do projeto 
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Figura 39: Layout final do Projeto 2 

 

 

Finalizamos a produção do nosso Mapa Temático dos Biomas no Brasil com divisão 

por Estados. 

Não esqueça!! Antes de fechar o ArcGIS Pro você deve salvar o projeto! 

 

 

 

 

 

 

 

 

 

 



 

49 
 

PROJETO 3 - Mapa de Calor (Densidade Kernel) Queimadas no Bioma 

Amazônia em 2022 

Objetivo: Elaborar um layout de mapa de calor (densidade de Kernel), referente às 

queimadas realizadas no bioma Amazônia no período de 01/01/2022 a 31/12/2022. Na 

figura abaixo está o layout a ser elaborado neste projeto. 

 

Figura 1:  Layout produto deste Projeto:  Mapa de calor – Densidade de Kernel – Bioma Amazônia 

em 2022 

 

 

Observações importantes: 

➔ Os arquivos não são salvos automaticamente, então trabalhe salvando o seu 

projeto sempre. 

➔ Operações de geoprocessamento a serem executadas: Recorte e projeção das 

camadas de mapa de calor (densidade de Kernel), referente às queimadas 

realizadas no bioma Amazônia. 

➔ Fonte de dados: Para obter os dados que serão utilizados nesse projeto, o usuário 

deverá acessar os links abaixo e selecionar os arquivos, escolha as malhas para o 

ano mais recente disponível: 

 

● Limites do Bioma Amazônia: 

○ Link: http://terrabrasilis.dpi.inpe.br/downloads/.  

http://terrabrasilis.dpi.inpe.br/downloads/
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○  Bioma Amazônia - Auxiliares > Limite do Bioma Amazônia - Shapefile 

● Queimadas:  

○ Link: https://queimadas.dgi.inpe.br/queimadas/bdqueimadas#exportar-

dados  

○ Para baixar esses dados é necessário enviá-los para seu email, o passo a 

passo está mais abaixo no ebook. 

● Unidades de Federação do Brasil:  

○ Link: https://portaldemapas.ibge.gov.br/portal.php#mapa223495.  

○ Organização do território > Malhas territoriais > Malha de unidade da 

Federação > Malha com todas as UFs > Brasil - Unidades da Federação 

2022 (SHP). 

Os dados baixados do Portal de Mapas do IBGE, Terra Brasilis e Programa Queimadas 

do INPE estão compactados. O usuário deve descompactá-los e copiá-los para um 

diretório de sua escolha (definir previamente o diretório).Salve em caminhos curtos, 

caminhos sem espaços e caracteres especiais, para o programa não ter problema de 

reconhecer os arquivos. Para isso, você deve criar as respectivas pastas no HD do seu 

computador, exemplo: salvar todos os arquivos descompactados dentro da mesma 

pasta “Cursos_ArcPro” em uma pasta “Download_Dados”.  

Objetiva-se por meio do presente tutorial, apresentar diversas ferramentas e operações 

que podem ser efetuadas no ArcGIS PRO e oportunizar o aprendizado no campo do 

Geoprocessamento. 

Criando o projeto  

Abra o ArcGIS Pro, inicie um novo projeto clicando em MAP/MAPA, nomeie o projeto 

como Mapa_de_Calor (importante não criar nomes com espaços). Escolha o local para 

salvar o projeto em seu computador e clique em OK. 

 

Figura 2: Como iniciar um novo projeto 

 

  

 

 

https://queimadas.dgi.inpe.br/queimadas/bdqueimadas#exportar-dados
https://queimadas.dgi.inpe.br/queimadas/bdqueimadas#exportar-dados
https://portaldemapas.ibge.gov.br/portal.php#mapa223495
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Observe que no CATALOG/CATÁLOGO, expandindo a FOLDERS/PASTAS, irá 

aparecer o GDB criado com o nome do arquivo.  

Figura 3: Exibindo onde está o GDB do arquivo 

   

Adicionando Shapefiles ao GDB 

Vamos importar FEATURES CLASSES/CLASSES DE FEIÇÕES para o GDB inicial. 

Ainda no CATALOG/CATÁLOGO, expanda a guia DATABASES/BANCOS DE 

DADOS. Em seguida, clique com o botão direito em cima do GDB Mapa_de_calor.gdb. 

Em seguida escolha IMPORT/IMPORTAR e FEATURES CLASSES/CLASSES DE 

FEIÇÕES. 

Figura 4: GDB e criação de FEATURES CLASSES. 
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Figura 5: Importando FEATURES CLASSES. 

 

 

Abrir a janela de GEOPROCESSING/GEOPROCESSAMENTO, clique na pasta 

referente a INPUT FEATURES/FEIÇÕES DE ENTRADA para escolher o arquivo que 

irá importar. Escolha todo o arquivo SHP que foi baixado no início do projeto, e clique 

em RUN/EXECUTAR.  

Figura 6: Como importar Features Classes 

  

 

Todos os FEATURES CLASSES/CLASSES DE FEIÇÕES serão inseridos ao GDB. 

Caso não estejam visíveis, clique com botão direito no GDB e escolha 

REFRESH/ATUALIZAR no canto superior direito, como na figura abaixo: 

Figura 7:  Refresh 
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Exibindo os arquivos no mapa 

Para exibir o shapefile que foi inserido no FEATURES CLASSES/CLASSES DE 

FEIÇÕES do GDB, na janela do CATALOG/CATÁLOGO, selecione o arquivo e arraste 

para área do mapa. 

Figura 8: Features classes inseridos no GDB 

 

 

Importante observar a coordenada de suas camadas, neste projeto usaremos sistema 

de coordenadas geográfica SIRGAS 2000, pois a área compreende mais de um Estado. 

Para conferir em qual coordenada está a camada, clique com botão direito na camada – 

PROPERTIES/PROPRIEDADES > SOURCE/FONTE> SPATIAL 

REFERENCE/REFERÊNCIA ESPACIAL, e lá vai estar o Sistema de Coordenadas 

Geográficas da camada, no caso será SIRGAS 2000. 

Figura 9: Conferindo o Sistema de Coordenada da camada 

 

 

Em seguida, é preciso verificar ou definir a coordenada geográfica do projeto, de acordo 

com as camadas. Clique com o botão direito em MAP/MAPA - 

PROPERTIES/PROPRIEDADES – COORDINATE SYSTEMS/SISTEMAS DE 

COORDENADAS. O projeto já estará automaticamente em SIRGAS 2000, pois o 
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ArcGIS deixa a coordenada do projeto de acordo com a coordenada do primeiro arquivo 

inserido.  

Figura 10: Conferindo o Sistema de Coordenadas do Projeto 

 

Alterando Simbologia da Camada 

Clique duas vezes no retângulo colorido abaixo da camada brazilian_legal_amazon para 

ativar a janela do lado direito e alterar sua simbologia. Iremos escolher contorno preto 

e sem preenchimento para a camada. 

Outra opção é clicar em APPEARANCE/CAMADA DE FEIÇÕES – 

SYMBOLOGY/SIMBOLOGIA. Será aberta a janela SYMBOLOGY/SIMBOLOGIA 

no lado direito da tela.  

Figura 11: Alterando simbologia da camada 

 

 

Baixando os dados de Focos de queimadas 

Entre no site do INPE https://queimadas.dgi.inpe.br/queimadas/bdqueimadas#exportar-

dados e configurar os dados para exportar para esse projeto, conforme imagem abaixo. 

Escolha a análise temporal de 01/01/2022 a 31/12/2022. Insira seu e-mail e escolha o 

formato de exportação para shapefile. Um e-mail será enviado com o link para baixar o 

arquivo. 

 

 

https://queimadas.dgi.inpe.br/queimadas/bdqueimadas#exportar-dados
https://queimadas.dgi.inpe.br/queimadas/bdqueimadas#exportar-dados
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Figura 12: Exportando dados de queimadas do INPE 

 

 

Após fazer o download dos dados e extrair o arquivo compactado, insira a nova feature 

class/classe de feição no GDB do projeto. Execute a ação e insira os dados no mapa.  

 

Figura 13: Inserindo dados de queimada no mapa 

 

 

Reprojetando sistema de coordenada da camada 

Sempre que inserir uma nova camada, verifique qual sistema de coordenada ela está 

projetada. A camada Focos_2022_01_01_2022_12_31 do projeto está em WGS 1984. 

Será necessário reprojetar para SIRGAS 2000, coordenada do projeto e da camada do 

bioma Amazônia. 
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Figura 14: Sistema de coordenada da camada focos de queimada 

 

 

Para reprojetar, clique na camada, vá em ANALYSIS/ANÁLISE – 

TOOLS/FERRAMENTAS e busque por PROJECT/PROJETAR. 

Figura 15: Caminho para projetar a camada 

 

 

Em seguida preencha qual camada será projetada (Focos) e escolha a coordenada que será 

utilizada SIRGAS 2000. Clique em executar. Uma nova camada será criada, assim, a 

camada que está com a coordenada WGS 1984 pode ser excluída do projeto. 

Figura 16: Projetando camada para SIRGAS 2000 

 

Clique na camada criada, aperte F2 e renomeie para Focos Queimadas 2022. 
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Aplicando densidade de Kernel 

Vá em ANALYSIS/ANÁLISE – TOOLS/FERRAMENTAS e busque por KERNEL. 

Na tabela de atributos você vai ter uma última coluna chamada FRP, que corresponde a 

potência/energia do fogo no foco de queimada. Essa coluna será informada em 

POPULATION FIELD/CAMPO DE PREENCHIMENTO. Preencha conforme 

imagem abaixo. Antes de clicar em RUN/EXECUTAR, vá em 

ENVIRONMENTS/AMBIENTES  e em MASK escolha a camada dos Limites da 

Amazônia e a extensão de visualização da tela. 

Figura 17:  Preenchimento da Densidade Kernel 

 

Mudando simbologia da camada Raster 

Vamos mudar a simbologia da camada criada, clicando na camada, vá em 

APPEARANCE/CAMADA RASTER – SYMBOLOGY/SIMBOLOGIA. Será aberta 

a janela SYMBOLOGY/SIMBOLOGIA no lado direito da tela. Em métodos escolha a 

simbologia padrão (primeiro item). Em classes coloque o número 5. E em color mude a 

cor para o esquema laranja-amarelo-vermelho. 

Figura 18: Mudando simbologia da camada densidade de Kernel 
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Ainda em APPEARANCE/CAMADA RASTER escolha o tipo de reamostragem para 

CÚBICO, as informações ficaram mais suaves e com menos pixel na imagem, 

melhorando a visualização. 

Figura 19: Mudando o tipo de amostragem da imagem 

  

Inserindo Mapa do Brasil 

Vamos fazer um mapa de localização do bioma Amazônia no Brasil. Clique em INSERT 

e abra um novo mapa. Em seguida, faça o mesmo processo de inserir um feature class no 

GDB do projeto. Vamos inserir o shapefile referente ao Brasil, que foi feito download na 

base do IBGE. 

Em seguida, insira a informação para a área do mapa. Edite o símbolo clicando no 

retângulo colorido abaixo da camada, retire a cor de plano de fundo, e deixe as linhas de 

contorno pretas.  

Figura 20: Inserindo e editando o Mapa do Brasil 

 

 

Em seguida, no primeiro mapa criado com a Densidade de Kernel, copie a camada 

referente Limites do Bioma Amazônia(clique com o botão direito e selecione 

COPY/COPIAR). Cole as informações na aba do mapa do Brasil(clique com o botão 
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direito e selecione PASTE/COLAR). Edite a simbologia dessa camada, escolhendo cor 

de fundo verde. Lembre-se de enviar essa camada para abaixo da camada do mapa do 

Brasil, para que os limites estaduais fiquem visíveis. 

Figura 21: Editando símbolo dos limites do bioma no mapa do Brasil 

 

Criando Layout do Mapa de Calor das Queimadas  

No menu clique na aba INSERT/INSERIR – NEW LAYOUT/NOVO LAYOUT e 

escolha o formato A4 –RETRATO. Clique com botão direito sobre a régua na tela de 

criação do layout, para adicionar margens na folha, escolha ADD 

GUIDERS/ADICIONAR GUIAS.  

Figura 22: Editando as margens do layout 

 

Em seguida escolha BOTH/AMBOS, em PLACEMENT/DISPOSIÇÃO escolha 

OFFSET FROM EDGE/DESLOCAR DA EXTREMIDADE. Em 

MARGIN/MARGEM, insira um afastamento da margem de 3mm e clique em OK. 

Figura 23: Editando as margens do layout 
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Para inserir o mapa na tela, escolha MAP FRAME/ESTRUTURA DO MAPA, e 

escolha o mapa que foi construído. 

Figura 24: Inserindo o mapa no layout 

  

 

Em seguida, faça o retângulo dentro da margem que foi criada no layout. O mapa será 

inserido na tela. Para mover ou alterar o zoom do mapa, clique na aba LAYOUT e em 

seguida ACTIVATE/ATIVAR. Após configurar o mapa na margem, clique que 

LAYOUT e CLOSE ACTIVATION/FECHAR ATIVAÇÃO.  

 

Agora vamos adicionar o GRID/GRADE de Coordenadas. Clique na aba 

INSERT/INSERIR – GRID/GRADE. Escolha uma grade de graus, por estar 

trabalhando em sistema de coordenadas geográficas SIRGAS 2000. Vamos escolher a 

que já coloca a grade lateral na posição vertical. 

Figura 25: Como inserir a grade de coordenadas no projeto  
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Para editar a grade de coordenadas, clique duas vezes na camada GRID/GRADE criada. 

Uma janela de edição irá abrir no lado direito da tela. Desabilite a opção 

AUTOMATICALLY ADJUST/AJUSTAR AUTOMATICAMENTE, para poder 

editar o GRID.  

Figura 26: Editando as linhas de grade do projeto 

  

 

Vamos retirar as grades de coordenadas de cima do desenho, clicando duas vezes na 

camada de GRID. Em seguida, escolha o componente GRID LINES/LINHAS DE 

GRADE, clique no X, ou em SYMBOL/SÍMBOLO escolher NO COLOR. 

  

Figura 27: Projeto com linhas de grade de coordenadas x Projeto sem linhas de grade de 

coordenadas 
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Para colocar um título no seu mapa, vá em INSERT/INSERIR e em seguida clique na 

opção STRAIGHT TEXT/TEXTO RETO. Em seguida faça um retângulo na área do 

mapa para inserir o título DENSIDADE KERNEL - QUEIMADAS EM 2022 NO 

BIOMA AMAZÔNIA. Para editar o texto, clique na camada TEXT criada no lado 

esquerdo e na janela do lado direito, altere a fonte e tamanho do texto. 

 

Figura 28: Inserindo Título ao mapa 

 

 

- Selecione o MAP FRAME/ESTRUTURA DO MAPA, para inserir a indicação do Norte. 

Clique em INSERT/INSERIR e escolha um NORTE, clique na área do mapa para inserir. 

Figura 29: Inserindo informação do Norte no mapa 

  

 

Antes de inserir a legenda, mude o nome da camada KernelD_Foco1 para Focos de 

Queimada. Para inserir a legenda no mapa, clique e INSERT/INSERIR e em seguida 

escolha LEGEND/LEGENDA. Na área do mapa, clique e forme o retângulo para inserir 

a legenda.  
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Figura 30: Inserindo legenda ao mapa 

 

 

Para destacar a legenda, vamos inserir um retângulo. Clique em INSERT/INSERIR e 

escolha um retângulo. Desenho o retângulo contornando a área da legenda. 

 

Figura 31: Criando retângulo de destaque para a legenda 

 

 

Em seguida, na edição do retângulo, em SYMBOL, escolha a cor CINZA de plano de 

fundo, e 0,5 para a espessura do contorno. Clique em APPLY. Se a informação da legenda 

sumir, do lado esquerdo, puxe a camada do Retângulo para abaixo da camada Legenda, 

para que possa aparecer as informações da legenda.  

 

 



 

64 
 

Figura 32: Editando retângulo inserido na legenda ao mapa 

 

 

- Para inserir a informação de escala, clique em MAP FRAME, em seguida INSERT e 

escolha SCALE BAR/BARRA DE ESCALA. Escolha uma escala da barra metros. 

Clique na área do mapa e arraste. A escala trará a informação “quilômetros”, na janela de 

edição do lado direito, em label text, digite KM. 

 

No lado direito, insira o mapa do Brasil com a localização do bioma no país. Para inserir 

o mapa na tela, escolha MAP FRAME/ESTRUTURA DO MAPA, e escolha o mapa do 

Brasil que foi construído. Insira a barra de escala nesse mapa de localização. 

 

Figura 33: Mapa de Localização do Bioma Amazônia 
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Inserindo informações no mapa 

Após inserir os dados no layout do mapa, vamos inserir as informações de fonte de dados. 

Clique em INSERT e escolha STRAIGHT TEXT/TEXTO RETO. Clique e arraste na 

área do mapa. Se o texto já aparecer grande, clique em FORMAT e escolha o tamanho 

do texto e cor. Para o mapa de calor, escolha o tamanho do texto 10, e cor preta. Insira as 

informações: 

 

FONTE:  

Limite Bioma Amazônia (Terra Brasilis, 2020).  

Foco de Queimada Bioma Amazônia (INPE, 2022). 

AUTOR: Insira seu nome 

Data: ___ / ___/ ____. 

Sistema de Coordenadas Geográficas 

Datum: SIRGAS 2000. 

 

Exportando o Mapa 

No menu, clique em SHARE/COMPARTILHAR – EXPORT 

LAYOUT/EXPORTAR LAYOUT. Escolha a pasta que deseja guardar o arquivo e 

nomeie o mapa para MAPA DE CALOR. Escolha o tipo de arquivo para JPEG. E em 

seguida clique em EXPORT/EXPORTAR. 

Figura 34:  Exportando o mapa do projeto 
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Figura 35:  Layout Final do Projeto 3 

 

 

Finalizamos a produção do nosso Mapa de Calor – Densidade Kernel - Queimadas 

no bioma Amazônia em 2022 

Não esqueça!! Antes de fechar o ArcGIS Pro você deve salvar o projeto! 
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PROJETO 4 – Mapa Topográfico do Município de Itajubá – MG 

Objetivo: Elaborar um layout de um mapa topográfico no território brasileiro utilizando 

o ArcGIS Pro. A Figura 1, a seguir, mostra o layout a ser elaborado ao término deste 

Projeto. 

Figura 1. Layout produto deste Projeto: Mapa Topográfico do município de Itajubá – Minas Gerais.  

 

 

Observações importantes: 

➔ Os arquivos não são salvos automaticamente, então trabalhe salvando o seu 

projeto sempre. 

➔ Operações de geoprocessamento a serem executadas: Recorte, reprojeção de 

camada, criação de curvas de nível, suavização de curvas de nível, entre outras 

necessárias neste projeto. 

➔ Fonte de dados: Para obter os dados que serão utilizados nesse projeto, o usuário 

deverá acessar os links abaixo e selecionar os arquivos, escolha as malhas para o 

ano mais recente disponível: 

 

● Malha Municipal Minas Gerais: 

○ Link: https://www.ibge.gov.br/geociencias/organizacao-do-

territorio/malhas-territoriais.html).  

 

https://www.ibge.gov.br/geociencias/organizacao-do-territorio/malhas-territoriais.html
https://www.ibge.gov.br/geociencias/organizacao-do-territorio/malhas-territoriais.html


 

68 
 

○ Organização do Território > Malhas Territoriais > Malha Municipal > 

Minas Gerais > Municípios.  

 

Os dados baixados do Portal de Mapas do IBGE, Terra Brasilis e Programa Queimadas 

do INPE estão compactados. O usuário deve descompactá-los e copiá-los para um 

diretório de sua escolha (definir previamente o diretório).Salve em caminhos curtos, 

caminhos sem espaços e caracteres especiais, para o programa não ter problema de 

reconhecer os arquivos. Para isso, você deve criar as respectivas pastas no HD do seu 

computador, exemplo: salvar todos os arquivos descompactados dentro da mesma 

pasta “Cursos_ArcPro” em uma pasta “Download_Dados”.  

Objetiva-se por meio do presente tutorial, apresentar diversas ferramentas e operações 

que podem ser efetuadas no ArcGIS PRO e oportunizar o aprendizado no campo do 

Geoprocessamento. 

Abrindo o ArcGIS Pro 

Após abrir o ArcGIS Pro, o usuário deve escolher a opção Mapa (Map), conforme Figura 

2. 

Figura 2: Abrindo o ArcGIS Pro 

 

Para iniciar um Novo Projeto no ArcGIS Pro, o usuário deve criar um projeto do zero, 

conforme a Figura 3. Lembrando que o projeto deve ser salvo no diretório selecionado 

pelo usuário. Após definido o nome do projeto e o diretório, clicar em OK. 

Figura 3: Criando um Novo Projeto 

 

Quando o usuário cria um Novo Projeto no ArcGIS Pro, a opção “Cria uma nova pasta 

para este projeto” está marcada. Dessa forma, serão armazenados dois arquivos com 

mesmo nome do projeto, sendo eles: um com a extensão .gdb (geodatabase ou banco de 

dados geográficos) e o outro com a extensão .tbx (caixa de ferramentas). Ou seja, quando 
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criamos um Projeto, automaticamente, estamos criando um geodatabase deste projeto 

com o mesmo nome. 

A seguir, será aberta a tela inicial do ArcGIS Pro (Figura 4). 

Figura 4: Tela inicial do Mapa – ArcGIS Pro 

 

 

Adicionando Shapefiles ao GDB 

Adicionando os dados na aba MAP/MAPA > ADICIONAR DADOS, conforme ilustra 

a Figura 5, a seguir. 

Figura 5: Adicionando dados 

 

 

Após selecionar o arquivo shapefile de interesse, clique em OK. Lembrando que depois 

de descompactar os arquivos, todos devem ficar na pasta/diretório. 
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Figura 6: Adicionando o shapefile (shp) de interesse 

 

 

O mapa que deverá aparecer, após inserida uma nova camada, encontra-se ilustrado a 

seguir (Figura 7). Observe que na janela Conteúdo, ao lado esquerdo, surge uma nova 

camada intitulada por MG_Municípios_2021. 

Figura 7: Mapa dos municípios de Minas Gerais 

 

Definindo a área de interesse 

O usuário poderá definir a área de interesse. Nesse caso, o município selecionado será: 

Itajubá em Minas Gerais. Para isso, faremos o recorte para esse município. Dessa forma, 

iniciaremos a executar operações de geoprocessamento com os dados utilizados.  

Inicialmente, faremos o recorte para o município de Itajubá. Para isso, o usuário deverá 

clicar com o botão direito sobre a camada MG_Municípios_2021 e selecionar a opção 

TABELA DE ATRIBUTOS. 
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Figura 8: Abrindo a Tabela de Atributos 

 

 

Na Figura 9, a seguir, podemos observar a Tabela de Atributos que irá aparecer 

posicionada abaixo do mapa. 

Figura 9: Tabela de Atributos abaixo do mapa 

 

Realizando operações de geoprocessamento (Selecionando e exportando feição) 

Em seguida, como o nosso interesse é realizar um RECORTE e selecionar apenas um 

município dentre os municípios de Minas Gerais, o usuário poderá clicar na opção 

SELECT BY ATTRIBUTES/ SELECIONAR POR ATRIBUTOS, conforme 

destacado a seguir. Importante: como o interesse é gerar um mapa do município de 

Itajubá, deve-se observar na Tabela de Atributos, qual a coluna que armazena essas 

informações e como esta encontra-se nomeada.  
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Figura 10: Selecionar Atributo na Tabela 

 

Para atingir tal finalidade, na janela Selecionar por Atributo, adicionar uma cláusula à 

camada, sendo ela: selecionar a coluna NM_MUN (onde estão armazenadas as 

informações com os nomes dos municípios) é igual à e, selecionar ITAJUBÁ, conforme 

ilustrado a seguir, e clicar em APLICAR. 

Figura 11: Seleção da área de interesse, Itajubá – MG 

 

No Mapa, é possível verificar que a área foi selecionada e encontra-se destacada como 

mostra a Figura 12. 
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Figura 12:  Município de Itajubá, selecionado dentro do estado de Minas Gerais e destacado em azul

 

No canto inferior da Tabela de Atributos, observa-se a opção SHOW SELECTED 

RECORD/MOSTRAR APENAS O ARQUIVO SELECIONADO, sendo nesse caso, 

o município de Itajubá.  

Figura 13: Selecionando apenas o recorte na Tabela de Atributos 

 

Em seguida, com o município selecionado nesta camada (tarja azul, como mostrado 

acima) em Conteúdo, clique com o botão direito do mouse sobre a camada e escolha 

Dados > Exportar Feições e exporte essa feição do tipo polígono para dentro do banco 

de dados geográficos (Figura 14). Note que é necessário indicar o nome do município. 
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Figura 14:  Criando uma nova camada a partir do recorte realizado.

 

Como dito, se faz necessário indicar o nome da nova camada. Nesse caso, foi indicado o 

nome MG_Municípios_Itajubá. 

Figura 15: Indicando o nome da nova camada 

 

 

Criada a camada MG_Municípios_Itajubá, como mostra a Figura 16, abaixo. 
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Figura 16: Nova camada constando no banco de dados (geodatabase)

 

Lembre-se: A cada mudança feita, aperte com o botão direito em cima da camada 

alterada e aplique o “refresh” para sua atualização. 

ATENÇÃO: Para evitar que seja necessário carregar os dados constantemente, tornando 

o processamento dessas informações lento, desmarcar a opção MG_Municípios_2022, 

selecione apenas a camada referente ao município que será alvo do presente projeto. 

Realizando operações de geoprocessamento (Recortando camada e reprojetando) 

Qual o sistema de coordenadas que está sendo trabalhado? 

IMPORTANTE: Essa informação é primordial para criar um mapa correto. Por se tratar 

de uma área pequena, é importante verificar se a área de interesse está localizada em 

apenas uma zona UTM. Caso esteja em apenas uma zona, poderemos trabalhar com 

coordenadas UTM. Caso contrário, o ideal é trabalhar com coordenadas geográficas. A 

área toda de interesse para esse projeto está localizada em uma única zona UTM, a ZONA 

23. Dessa forma, poderemos trabalhar com coordenadas UTM. 

Para garantir que o mapa esteja no sistema de coordenadas correto, o usuário deverá clicar 

sobre a camada do Mapa_Principal com o botão direito e clicar em Propriedades > 

Sistema de Coordenadas e selecionar SIRGAS 2000 UTM ZONA 23S (Figura 17). 
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Figura 17: Colocando o mapa em SIRGAS 2000 UTM Zone 23S, o sistema de coordenadas adequado para a 

localização

 

Essa seleção foi aplicada para o projeto. Dessa forma, precisamos deixar a camada alvo 

com o mesmo sistema de coordenadas. Selecionar a camada MG_Municípios_Itajubá. 

Agora, será preciso realizar uma operação de geoprocessamento conhecida como 

Projetar. Selecionar em Análise > Ferramentas para abrir a janela de 

Geoprocessamento. 

Figura 18: Abrindo a janela de Geoprocessamento 

 

 

Para projetar a camada sobre o mapa, insira as informações referentes ao conjunto de 

dados ou classe de feição de entrada, classe de feição de saída e Sistema de Coordenadas 

de Saída, o qual deve ser igual ao do projeto (SIRGAS 2000 UTM ZONA 23S) e em 

seguida clicar em EXECUTAR, conforme ilustra a Figura 19. 
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Figura 19: Projetando uma camada sobre outra camada, com o mesmo sistema de coordenadas

 

Observa-se que é criada uma nova camada. É importante renomear a camada, (clicando 

apenas em cima do nome da camada, será dada essa opção) visto que a camada estará 

representada na legenda, sendo importante deixar os nomes definidos de acordo com a 

representação que se quer ao término do projeto. Nesse caso, a camada projetada foi 

nomeada de Itajubá (MG). 

IMPORTANTE: Independente de quantas camadas forem criadas, é importante observar 

se todas elas estão com o mesmo sistema de coordenadas. 

Figura 20: Criando uma camada projetada, objetivando manter o sistema de coordenadas do projeto 

 

Clique com o botão direito sobre a camada e selecione ZOOM NA CAMADA (ZOOM 

TO LAYER) para permitir que a visualização da tela fique de acordo com o mapa. 

Ao término, você verá a área de interesse (Figura 21). 
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Figura 21: Visualização da camada criada no mapa 

 

 

Observa-se que a área está preenchida na cor rosa e não conseguimos observar o que tem 

dentro desta área. Clicando com o botão direito sobre a camada e abrindo a caixa de 

SIMBOLOGIA, poderemos alterar essa propriedade, como é mostrado a seguir. 

Nesse caso, foi optado por retirar o preenchimento, selecionar a cor vermelha para o 

contorno, 2 pontos de largura da linha e, ao término, deve-se clicar em APLICAR, como 

é mostrado na imagem, a seguir. 

Figura 22: Selecionando as propriedades da simbologia dessa camada 

 

Realizando operação de importação de camadas da nuvem do ArcGIS Pro e 

definição de MDE 

Observa-se que os mapas topográficos Mundial que já estão no ArcGIS Pro, possuem 

uma noção de relevo. Iremos criar uma camada com altitude pegando da nuvem. Para 

isso, selecione a opção Adicionar Camada > Living Atlas > Terrain (na aba catálogo), 

como mostrado a seguir. 
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Figura 23: Selecionando o Map Terrain do banco de dados do ArcGIS Pro para incorporar ao mapa do 

Projeto 

 

Após selecionada a camada Terrain, o mapa que será visualizado é apresentado a seguir 

(Figura 24). 

Figura 24: Mapa de elevação/altimetria Terrain em destaque 

 

TESTE: Ao clicar em qualquer ponto do mapa, o usuário poderá observar que irão 

aparecer 6 tipos diferentes de Modelos Digitais de Elevação (DEM ou MDE, em 

português). Dessa forma, não é interessante utilizar os 6 tipos, é preciso filtrar o MDE 

mais próximo do modelo de elevação do Brasil.  

Para isso, selecione o Product Name que aparece abaixo, para o MDE 

WorldDEM_WDO_08_S23_00_W046_00_DEM, a seguir ilustrado: 
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Figura 25: Seleção do MDE mais próximo para o Brasil

 

Em seguida, o usuário deverá clicar com o botão direito sobre a camada Terrain e 

selecionar PROPERTIES/PROPRIEDADES > Definition Query/Consulta de Definição 

e criar uma consulta, a qual deverá ser: Product Name é igual à 

‘Airbus_WorldDEM4Ortho_24m’ e clicar em APLICAR, como é mostrado na 

Figura 26, a seguir. 

Figura 26: Definir o MDE adequado para o Brasil 

 

Aparecerá dessa forma: 
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Figura 27: Definido MDE para o mapa

 

A partir desse momento, ao clicar em qualquer ponto do mapa, será possível observar que 

só aparecerá um MDE, o selecionado, como podemos ver na imagem a seguir. 

Figura 28: Ao clicar em qualquer ponto do mapa, podemos observar que o MDE selecionado foi aplicado 

 

Não havendo necessidade de carregar o MDE para todo o globo, iremos recortar apenas 

para a área que irá abranger a nossa área de interesse, sendo Minas Gerais, o município 

de Itajubá. Para isso, seguiremos os passos que serão apresentados a seguir. 

Primeiramente, o usuário deverá clicar com o botão direito sobre a camada Terrain e 

selecionar Data/Dados > Export Raster/Exportar Raster (Figura 29). 
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Figura 29: Exportando Raster para criar uma nova camada, somente com a área de interesse 

 

 

Selecionar a opção Clipping Geometry/Recortando Geometria > 

MG_Municípios_Itajubá, que é a camada que contém a nossa área de interesse para 

elaboração do mapa topográfico. O preenchimento deverá ocorrer como ilustra a Figura 

30. 

Figura 30: Exportando raster - preenchimento parte 1 

 

Ainda dando continuidade ao preenchimento da janela “Exportar Raster”, abaixo será 

solicitada a definição do tamanho do X e do Y. Para isso, o usuário deverá preencher 

como sendo 25 para os dois (o tamanho do meu pixel ou a resolução). 
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Figura 31: Exportando raster – preenchimento parte 2

 

DICA: Para não ficar com a borda preta, o interessante é colocar em No Data Value 

/Valores de No Data = -99999, como ilustrado a seguir e EXPORT/EXPORTAR 

(Figura 32). 

Figura 32: Exportando raster – preenchimento final 

 

Por fim, pode desmarcar a camada Terrain e observar que o resultado será o ilustrado a 

seguir, Figura 33. Observe que foi criada uma nova camada, cujo nome é Terrain_1.tif. 
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Figura 33:  Resultado final, criação de uma nova camada com o MDE selecionado para a área de interesse

 

Realizando operações de geoprocessamento (Curvas de nível, Suavização de Linhas) 

Agora podemos transformar o nosso MDE – Modelo Digital de Elevação em curvas de 

nível. Para isso, iremos utilizar uma ferramenta chamada CONTOUR/CURVA DE 

NÍVEL. O caminho utilizado será Analysis/Análise > Tools/Ferramentas > 

Geoprocessing/Geoprocessamento > Contour/Curva de Nível, e irá aparecer da 

seguinte forma: 

Figura 34: Buscando pela ferramenta “Curva de Nível” no ArcGIS Pro 

 

O usuário deverá alterar o nome da nova camada (Terrain_1.tif) para MDE Recortado e 

prosseguir com o geoprocessamento. 

O raster de entrada deverá ser a camada MDE Recortado. O intervalo da curva de nível 

poderá ser de 50m. Não sendo necessário informar mais nada, prosseguir com 

EXECUTAR, conforme ilustrado abaixo (Figura 35). 
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Figura 35: Criando curvas de nível a partir de uma camada 

 

 

O resultado que irá aparecer será ilustrado a seguir. 

Figura 36: Nova camada contendo curvas de nível com 50m de distância 

 

 

Podemos desmarcar as outras camadas e deixar apenas as curvas de nível. Alterar o nome 

da nova camada (Contour_Terrain1) para Curvas de Nível (50m). 
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Figura 37: Deixar aparente apenas as curvas de nível. 

 

Para deixar as linhas com elevações menos pontiagudas, é importante atenuar essas 

elevações. Para isso, iremos utilizar a ferramenta SMOOTH/ SUAVIZAR LINHA. A 

seguir, deverão ser preenchidas as informações:  

- Feição de entrada (inserir a camada referente às curvas de nível);  

- Tolerância de suavização (50m, sendo que ao observar se foi suavizado demais ou para 

menos, esse valor poderá ser alterado, ficando a critério do usuário); 

- Manipular Erros Topológicos, selecionando a opção “Resolve topological errors”, e 

clicar em EXECUTAR, como é mostrado a seguir. 

Figura 38: Utilizando a ferramenta de geoprocessamento "Suavizar Linha" 

 

Para observar a diferença entre a camada “Curvas de Nível (50m)” e a nova camada 

criada “CurvasdeNível50m_SmoothLine”, o usuário poderá alterar com o botão direito 

sobre as respectivas camadas em SYMBOLOGY/SIMBOLOGIA, as cores das linhas, 
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permitindo uma visualização das curvas antes e depois do procedimento de suavização, 

como é mostrado a seguir, na Figura 39. 

Figura 39: Zoom para visualização das curvas de nível antes e depois do procedimento de suavização 

 

Separando as Curvas de Nível e adequando a visualização em mapas 

Em seguida, iremos separar as curvas em primárias e secundárias, separadas pelo 

intervalo de 100/100m. Com o botão direito sobre a camada 

“CurvasdeNível50m_SmoothLine”, clique em "Tabela de Atributos”. Ao abrir a tabela, 

criar uma coluna: ADICIONAR CAMPO. 

Figura 40: Adicionar campo em uma Tabela de Atributos 

 

Em seguida, preencher conforme ilustra a Figura 41. 

 

 

 Observar que a diferença entre as camadas, 

embora seja suave, é notório que as curvas 

ficaram mais suavizadas e provavelmente 

indicam maior proximidade com a realidade. 
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Figura 41: Preenchimento da coluna na Tabela de Atributos 

 

 

Após a criação dessa nova coluna na Tabela de Atributos, que contém as informações 

existentes na camada “CurvasdeNível50m_SmoothLine”, o usuário poderá criar um 

filtro. Para isso, o usuário deverá clicar com o botão direito sobre a referida camada, clicar 

em Properties/Propriedades > Definition Query/Consulta de Definição. 

Iremos inserir uma equação que irá selecionar as elevações que são denominadores de 

100. Sendo ela: “MOD(Contour, 100)=0”, em seguida clicar em APPLY/APLICAR, 

como ilustrado abaixo. 

Figura 42: Definindo um filtro para a camada 

 

Retornando a Tabela de Atributos, o usuário poderá selecionar na coluna “Type/Tipo”, 

com o botão direito selecionar "Calculate Field/Calcular Campo”. Dessa forma, 

poderemos criar duas camadas, separando as curvas de nível primárias e curvas de nível 

secundárias. 

 

 

 

 

 

 

 

 



 

89 
 

Figura 43: Criando as curvas de nível primárias e secundárias - parte 1 

 

Para as curvas que iremos chamar de Curvas Primárias, cujos contornos são 

denominadores de 100, iremos filtrar: 

Figura 44: Criando as curvas de nível primárias 

 

Agora, iremos selecionar as curvas secundárias, que serão aquelas cuja divisão não será 

igual a 1, voltando na Properties/Propriedade da camada suavizada 

(“CurvasdeNível50m_SmoothLine”). O usuário poderá criar um Filtro. Para isso, o 

usuário deverá clicar com o botão direito sobre a referida camada, clicar em 

Properties/Propriedades > Definition Query/Consulta de Definição e editar a fórmula 

para: “MOD(Contour, 100)<>0” (diferente de 0) em seguida clicar em 

APPLY/APLICAR. 
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Figura 45: Criando novo filtro para as curvas de nível secundárias 

 

Para a camada secundária, retornando a Tabela de Atributos, o usuário poderá selecionar 

na coluna“Type/Tipo” e com o botão direito selecionar "Calculate Field/Calcular 

Campo”. Dessa forma, poderemos criar a segunda camada, separando as curvas de nível 

primárias e curvas de nível secundárias, conforme demonstrado abaixo. 

Figura 46: Criando as curvas de nível secundárias 

 

Agora, podemos simplesmente remover o filtro, retornando em 

Properties/Propriedades da camada, e observar que a coluna gerada na Attribute 

Table/Tabela de Atributos, Type/Tipo, a qual é uma classe numérica, possui 1 ou 2, 

como iremos visualizar a seguir. 
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Figura 47: Concluída a criação de uma nova coluna na Tabela de Atributos, separando as curvas em 

primárias e secundárias 

 

Figura 48: Eliminando o filtro criado anteriormente, após a conclusão da definição da Coluna na Tabela de 

Atributos 

 

 

Agora iremos trabalhar a SYMBOLOGY/SIMBOLOGIA dessa camada 

(“CurvasdeNível50m_SmoothLine”). O usuário deverá selecionar sobre a camada, com 

o botão direito, o item Symbology/Simbologia.  
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Figura 49: Acessando a Simbologia da camada

 

O usuário irá alterar o rótulo para Primárias e Secundárias, manualmente, como mostra a 

imagem na Figura 50. Dessa forma, iremos alterar os rótulos das classes que compõem a 

camada. 

Figura 50: Alterando o rótulo das classes que compõem a camada "CurvasdeNível50m_SmoothLine" 

 

Sobre cada um dos tipos, pode-se escolher as cores e largura das linhas. Para a 

“Primárias”, foi selecionada a cor preta com 1 ponto de largura e para a “Secundárias”, 

cor PRETA e 0,5 pontos, conforme ilustrado a seguir. Para realizar essas alterações, basta 

acessar a Simbologia, como demonstrado anteriormente. O resultado permite uma melhor 

visualização das curvas de nível. 

 

 

 

 

 



 

93 
 

Figura 51: Definição das propriedades das feições primárias e secundárias da camada 

"CurvasdeNível50m_SmoothLine" 

 

Agora iremos trabalhar com o Label/Rótulo das curvas primárias, ou seja, somente as 

curvas de nível que possuem altitude com denominador de 100. O usuário deverá clicar 

com o botão direito sobre a camada “CurvasdeNível50m_SmoothLine” e habilitar o 

Label/Rótulo. Em seguida, na aba de ferramentas, ir em Rotulação > Consulta SQL. 

Figura 52: Acessando a Rotulação da camada. 

 

Em seguida, selecionar “Type/Tipo” é igual a “1” e APPLY/APLICAR. Como dito 

anteriormente, para ficar visível no mapa, é preciso habilitar o Label/Rótulo na camada 

selecionada. 

Figura 53: Habilitando a visualização dos rótulos nas classes 
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Após aplicado, poderemos visualizar as marcações no mapa indicando a altitude desses 

pontos, conforme ilustra a Figura 54, a seguir. 

Figura 54: Visualizando os rótulos no mapa, indicando a altimetria das curvas de nível traçadas 

 

A forma como aparece não é tida como convencional para mapas de topografia, visto que 

os rótulos aparecem em cima das curvas de nível, impedindo uma visualização adequada. 

Para alterar, selecionar o estilo de posicionamento do rótulo para CONTOUR 

LINES/CURVAS DE NÍVEL, como demonstrado a seguir. 

Figura 55: Alterando a rotulação para o tipo “Curvas de Nível” já indicado no ArcGIS Pro 

 

Em seguida, selecionar as opções abaixo para melhorar a visualização (Figura 56): 
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Figura 56: Melhorando a visualização dos rótulos 

 

Observa-se que ainda é preciso melhorar a visualização, visto que a linha passa por cima 

do rótulo e impede a leitura corretamente. Dessa forma, em Symbol/Símbolo > Halo, 

escolha o preenchimento branco e a largura para 2 pontos e clique em 

APPLY/APLICAR, como demonstrado a seguir. 

Figura 57: Melhorando a visualização dos rótulos 

 

A visualização final será a seguir ilustrada: 
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Figura 58: Visualização final com as curvas de nível primárias e secundárias e rótulos apenas das primárias 

 

A seguir, diminua o tamanho da fonte do rótulo para que o mapa não fique poluído com 

as informações. 

Gerando o Layout final 

Agora o mapa está pronto para ser gerado um layout. Para isso, em New Layout/Novo 

Layout, selecione a opção A4.  

Figura 59: Criando o layout do mapa gerado 

 

Em seguida, será aberta, dentro do ArcGIS Pro, a janela de Layout. Para facilitar o 

preenchimento das informações desejadas no Layout, o usuário deverá clicar na régua e 

selecionar Add Guides/Adicionar Guias, fazendo o preenchimento conforme ilustra a 

imagem.  
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Figura 60: Criando o layout do mapa gerado: adicionar guia. 

 

Ao criar o layout, selecionar Map Structure/Estrutura do Mapa e escolher o mapa 

criado. Após incluir o mapa, pode-se selecionar a camada “MDE Recortado”, dessa vez, 

selecionando através da Symbol/Simbologia, a variação de cor que melhor poderá 

representar o terreno, como ilustrado abaixo.  

Para evitar que seja alterada a propriedade desta camada, o usuário poderá clicar sobre a 

camada em Conteúdo, selecionar com tecla CTRL e arrastar para cima, gerando uma 

camada duplicada da “MDE Recortado”. Agora, poderá alterar as propriedades de cor 

dessa camada, mantendo a original intacta. Para isso, clique sobre a nova camada com o 

botão direito, selecione Symbol/Simbologia e na alteração de cor, escolha “Show 

Names/Mostrar nomes”. É possível observar que existem cores que são utilizadas como 

padrão para gerar certos tipos de mapa. No nosso caso, iremos utilizar a cor “Elevação 

#10”. 

Na escolha do mapa que será incluído no layout, é importante verificar qual a camada 

selecionada, como apresentado abaixo. 
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Figura 61: Duplicar a camada e selecionar a cor que se deseja trabalhar.

 

Observa-se através do mapa que ainda não é possível visualizar alguns relevos. Dessa 

forma, iremos utilizar uma outra ferramenta, Shaded Relief/Relevo Sombreado. Para 

acessar, deveremos abrir a janela de geoprocessamento, como feito em etapas anteriores. 

O preenchimento deverá seguir o padrão apresentado: 

Figura 62: Utilizando a ferramenta de geoprocessamento: Relevo Sombreado. 

 

O resultado será apresentado a seguir. Observe que surge uma nova camada. 
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Figura 63: Resultado do relevo sombreado aplicado.

 

Em seguida, podemos mesclar duas camadas e colocar o MULTIPLICADOR: 

Figura 64: Mesclando duas camadas. 

 

O resultado obtido através da mescla entre as duas camadas é apresentado a seguir. 
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Figura 65: Resultado final do mapa topográfico gerado para o município de Itajubá (MG).

 

Por fim, pode-se adicionar elementos importantes para o mapa, como Escala, Grid, Seta 

geográfica indicando Norte. 

Figura 66: Adicionando elementos importantes para o mapa. 

 

 

O Mapa final poderá ser gerado em pdf ou em jpeg, de acordo com a necessidade do 

usuário. A seguir, apresenta-se o mapa topográfico final gerado neste projeto. 
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Figura 67: Mapa Final do Projeto 

 

 

 

Finalizamos a produção do nosso Mapa Topográfico. 

Não esqueça!! Antes de fechar o ArcGIS Pro você deve salvar o projeto! 
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PROJETO 5 – Áreas Indicadas para Instalação de Aterro Sanitário- 

Análise Multicritério e Sobreposição Ponderada 

Projeto: Mapa de Álgebra de Mapas – Análise Multicritério. 

Objetivo: Criar layout indicando as áreas ótimas para a instalação de aterro sanitário na 

cidade de Recife utilizando a ferramenta ArcGIS Pro. Para isso foram estabelecidos os 

seguintes parâmetros: 

● O terreno não pode ter declividade maior que 10%; 
● A distância dos canais de drenagem deve ser maior que 300 metros; 
● A distância dos centros de ocupação (Urbanos) deve ser maior que 1 

Km e menor que 10 Km; 
● Declividade com um peso de 40 % na análise, Trecho de Drenagem 

com 35% e Centro Urbano com 25%. 

Haverá a execução de múltiplas ferramentas a fim de atingir o objetivo do presente projeto 

e produção do Layout final como na figura abaixo. 

Figura 1 – Layout produto deste Projeto: Mapa de análise multicritério 

 

Observações importantes: 

➔ Os arquivos não são salvos automaticamente, então trabalhe salvando o seu 

projeto sempre. 

➔ Operações de geoprocessamento a serem executadas: Recorte e projeção das 

camadas de mapa de calor (densidade de Kernel), referente às queimadas 

realizadas no bioma Amazônia. 
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➔ Fonte de dados: Para obter os dados que serão utilizados nesse projeto, o usuário 

deverá acessar os links abaixo e selecionar os arquivos, escolha as malhas para o 

ano mais recente disponível: 

 

● Trecho de Drenagem: 

o Link: 

https://metadados.snirh.gov.br/geonetwork/srv/por/catalog.search#/home  

o Na aba pesquisar digite Trecho de Drenagem 5K e efetue o download 

 

● Malha Municipal IBGE:  

o Link: https://www.ibge.gov.br/geociencias/organizacao-do-

territorio/malhas-territoriais/15774-malhas.html?=&t=downloads 

o Malha Municipal > Downloads > município_2022 > UFs > PE > 

PE_Municipios_2022.zip.  

● Modelo Digital de Elevação - Ferramenta online no ArcGIS PRO, constante no 

tutorial. 

 

Os dados baixados do Portal de Mapas do IBGE, Terra Brasilis e Programa Queimadas 

do INPE estão compactados. O usuário deve descompactá-los e copiá-los para um 

diretório de sua escolha (definir previamente o diretório).Salve em caminhos curtos, 

caminhos sem espaços e caracteres especiais, para o programa não ter problema de 

reconhecer os arquivos. Para isso, você deve criar as respectivas pastas no HD do seu 

computador, exemplo: salvar todos os arquivos descompactados dentro da mesma 

pasta “Cursos_ArcPro” em uma pasta “Download_Dados”.  

Objetiva-se por meio do presente tutorial, apresentar diversas ferramentas e operações 

que podem ser efetuadas no ArcGIS PRO e oportunizar o aprendizado no campo do 

Geoprocessamento. 

Abrindo o ArcGIS PRO. 

Figura 2: Iniciando projeto no ArcGIS PRO 

 

 

Na janela que aparece crie um novo projeto, nomeie o projeto como 

Análise_Multicritério (importante não criar nomes com espaços). Escolha o local para 

salvar o projeto em seu computador e clique em OK. 

https://metadados.snirh.gov.br/geonetwork/srv/por/catalog.search#/home
https://www.ibge.gov.br/geociencias/organizacao-do-territorio/malhas-territoriais/15774-malhas.html?=&t=downloads
https://www.ibge.gov.br/geociencias/organizacao-do-territorio/malhas-territoriais/15774-malhas.html?=&t=downloads
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Observação: Caso apareça a aba “Save changes to Untitled?”, clique em não salvar. 

Figura 3: Criando um projeto no ArcGIS PRO 

 

Quando o usuário cria um projeto no ArcGIS Pro, a opção de criar um folder para o 

projeto está marcada. Dentro do folder criado será armazenado dois arquivos com mesmo 

nome do projeto com a extensão. Gdb (geodatabase ou banco de dados geográficos) e o 

outro com tbx > (caixa de ferramenta). 

Após a criação do projeto, a seguinte tela aparece (View > Catalog Pane): 

 Figura 4: Visualizando o catálogo em aba e caixa 

 

Feche a Guia Catalog que está ativa (tarja azul). Verifique que a tela aparece da seguinte 

forma: 

Figura 5: Caixa de Catálogo e visualização da tela 

 

OBS: se estiver aberta a aba “Geoprocessamento”, feche-a para visualizar como está 

na imagem acima. 

. 
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Importando Features classes para o GDB 

- Expanda a guia Databases(Banco de dados) dentro do Catalog(Catálogo) 

- Clique com o botão direito do mouse sobre o Analise_multicriterio.gdb 

- Escolha Import > Feature Class(es) 

- Selecionar os shapefiles ou arquivos que irão compor o projeto. 

Figura 6: Importando “Classes de Feições” 

 

Obs: No caso do arquivo de Trechos de Drenagem, o mesmo será importado no 

formato gpkg (geopackage). Após a importação de todos os arquivos, clique com o 

mouse do canto direito e Atualizar/Refresh a fim de que os dados apareçam na 

“Analise_multicriterio.gdb”. 

 Figura 7: Importando dados para o geodatabase (gdb), conforme nomenclaturas da figura, e 

geoprocessamento efetuado com sucesso 
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Figura 8: Refresh 

 

 

Após a importação de dados efetuada com sucesso, selecionar todas as camadas 

constantes no “Analise_multicriterio.gdb” e, para fins de iniciar o trabalho com o mapa 

> “Adicionar no Mapa Atual/Add To Current Map”, conforme figura 7. Todos os 

arquivos irão para a aba CONTEÚDO/CONTENTS no geodatabase 

“Analise_multicriterio.gdb”. 

OBS: “geoft_bho_ach_otto_nivel_05.gpkd” é o arquivo de Trechos/Rede de 

drenagem. 

Figura 9: Adicionando os arquivos ao mapa atual. 

   

Iniciando o mapa. 

 

Após adicionar as camadas ao “Mapa Atual” o ArcGIS PRO carrega a imagem com todas 

as camadas importadas, conforme figura 8. 

A fim de nomear o mapa trabalhado de acordo com o objetivo do projeto, é possível 

renomear clicando no botão direito do mouse e selecionando propriedades.  O mapa foi 

renomeado como “LOC ÓTIMA ATERRO”. Facilitando, assim, a identificação do 

projeto em andamento. 
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Figura 10:  Aba conteúdo - Mapa com todas as camadas importadas

 

Após adicionar todas as camadas obtidas nas bases de dados, pode-se começar as 

operações no ArcGIS PRO. 

Para visualizar a camada “PE_Municipios_2021” clicar em cima com o botão direito e 

selecionar a opção “Zoom na Camada/Zoom to Layer” > a imagem dará o zoom na 

camada referente ao estado de Pernambuco, onde fica o município de interesse para início 

das operações “Recife”. 

OBS: Para melhor visualização, subir a camada “PE_Municipios_2021” como a 

primeira camada do mapa, figura 11. 

Figura 11: Selecionando a camada “PE_Municipios_2021” a fim de solicitar zoom na camada e 

aproximação da área de interesse e observação da camada. 

 

 

Figura 12: Estado de Pernambuco com os municípios, após zoom na camada selecionada 
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A camada de “Trecho de drenagem” apresentava em sua simbologia a cor violeta, a figura 

11 mostra o processo de mudança> clicando em cima da simbologia e escolhendo a cor 

azul, de acordo com característica da camada. 

Figura 13: Mudança de simbologia, cor, da camada Trecho de Drenagem para azul 

 

Obtendo o Modelo Digital de Elevação 

 

Para obter um mapa com as áreas “ótimas” para instalação de aterro no município de 

Recife, há a necessidade da camada MDE – Modelo Digital de Elevação. Há a 

possibilidade de obtenção de forma externa ao ArcGIS, inserindo como uma camada a 

mais, porém o programa já fornece de forma online a referida camada. 

MDE : Figuras 12 e 13; 

Adicionar dados/Add Data > Living Atlas > Terrain > Clicar “OK”. 
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Figura 14: Adicionando dados no ArcGIS PRO 

  

 

Figura 15: Na aba “adicionando dados” > Selecionar o Living Atlas e pesquisar a palavra 

“Terrain” para obtenção do MDE. Selecionar a opção “Terrain” sem mais complementos, 

conforme figura 

 

Figura 16: MDE camada “Terrain” carregada, ao fundo, com o modelo digital de elevação 
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Com o “Terrain” como mais uma camada na base de dados, já é possível iniciar as 

operações a fim de obtenção do projeto final proposto “Mapa de localização para 

instalação de Aterro Sanitário”. 

Recortando área de interesse. 

 

A fim de dar agilidade às operações de geoprocessamento que serão utilizadas e, também, 

dar mais assertividade na área de estudo, na geração do layout final, iniciaremos as 

operações de recorte da área de interesse. 

Figura 17: Seleção da camada para definir a cidade de interesse por meio da aba de “propriedades” 

  

Na aba Propriedades/Properties: Consulta de Definição/Definition Query > Nova 

Consulta de Definição/New Definition Query> “Onde” = NM_MUN “é igual a” 

Recife. Conforme figura 18: 

Figura 18: Definindo o município de Recife 
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Figura 19: Exportando Feições – gerando uma nova camada com o município de Recife

 

Clique com o botão direito na camada PE_Municipios_2021 > Dados/Data > 

Exportar Feições/Export Features > Feições de Entrada/Input Features = 

PE_Municipios_2021 e Feições de Saída/Output Feature Class = Recife  

A geração de uma nova camada “Recife” será de grande importância a fim de delimitar, 

também, as demais camadas e tornar mais fácil os processamentos das ferramentas de 

geoprocessamento. As demais camadas serão recortadas a partir da feição denominada 

de “Recife”, ou seja, o município.  

Figura 20: Gerando uma nova camada de feições com o município “Recife”. Ferramenta “Exportar 

Feições” 

 

 

Para fins de organização, visto que vários processamentos serão feitos, agruparemos as 

camadas de acordo com suas características. O primeiro agrupamento serão os dados 

brutos, ainda não tratados e processados. Para isso: Selecionar todas as camadas iniciais 
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> clicar com o lado direito do mouse > Selecionar “Agrupar/Group” > Clicar em 

cima da legenda criada e renomear. Observar a figura 19. 

OBS: Tal operação, de agrupamento, evitará futuras confusões, visto que lidaremos com 

manipulação de diversos dados e muitas operações serão feitas com as camadas, a fim de 

tratativa dos dados. 

Figura 21: Agrupamento dos dados. Seleção dos dados iniciais e agrupamento como “Dados 

Brutos” 

 

Tratando a camada “Recife” 

 

A Camada do município de “Recife” clicando com o botão direito do mouse > 

Simbologia/Symbology (Figura 20) > Clique no Símbolo (Figura 21) > Seleciona 

contorno preto (Figura 22) > Vai em Propriedades/Properties (Figura 23) > Seleciona 

Cor “Vermelho” e Largura do contorno 4 pt (Figura 23). 

Figura 22: Selecionando a opção Simbologia da Camada “Recife” 
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Figura 23: Selecionando a opção Símbolo para fins de abertura de novas opções e edição 

 

Figura 24: Selecionando contorno preto do polígono “Recife” > Seleciona a aba “Propriedades” 

para fins de edição de cor, aparência e contorno 

 

 

Figura 25:  Edição de propriedades do polígono na aba “Propriedades” 
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Verificando sistema de coordenadas 

 

É essencial verificar o sistema de coordenadas a ser utilizado antes de realizar as 

operações e processamento de dados. Se a área estudada abrange mais de um fuso, deve-

se usar o sistema de coordenadas geográficas, a fim de verificar qual o caso da área de 

estudo escolhida. Para a área “Recife”, vamos usar o sistema de coordenadas UTM, visto 

que a mesma se localiza na zona UTM 25. 

Adicionar dados/Add Data> Living Atlas > “UTM” (pesquisar) > clica em “World 

UTM Grid” > OK. 

IMPORTANTE: 

Será projetado em seu mapa a grade com as zonas UTM e poderá analisar qual o sistema 

de coordenada geográfica será adequado. Se a área de estudo contemplar apenas uma 

zona UTM, usar sistema de coordenadas planas, se mais de uma, usar sistema de 

coordenadas geográficas. 

Figura 26: Projetando a camada de sistema de coordenadas UTM. Verificar o sistema de 

coordenadas do projeto 

 

Clique com o botão direito do mouse na camada Recife > Zoom na Camada/Zoom to 

Layer > Clique em cima = Pop Up com a coordenada UTM.  

Para começar a trabalhar com o mapa da zona UTM correta: Clique com o botão direito 

do mouse no mapa renomeado > Sistema de Coordenadas > Sistema de Coordenadas 

Planas > UTM > South America > SIRGAS 2000 > SIRGAS 2000 UTM Zone 25 S > 

OK. 

Recife está localizado na zona UTM 25.  



 

115 
 

 

Figura 27: Adequando o sistema de Coordenadas do mapa 

 

Recortando as camadas no ArcGIS PRO. 

 

Iniciaremos o recorte do MDE – Modelo Digital de Elevação. Porém antes de dar início, 

é necessário definir as propriedades da camada, visto que a mesma apresenta diversos 

dados atrelados ao “Terrain”. Pode desmarcar a Zona UTM 

Na camada do MDE “Terrain” no mapa> Clique duas vezes > Observar os dados 

apresentados no Pop-up > Copiar o Product Name 

“Airbus_WorldDEM4Ortho_24m” > Fechar > Clicar na camada Terrain com tecla 

direita do mouse > Selecionar Propriedades/Properties > Consulta de Definição/New 

Definition Query > Onde “ProductName” é igual a 

“Airbus_WorldDEM4Ortho_24m” > Aplicar > OK. Após a operação, clicar duas 

vezes na camada e conferir se o Pop-up da camada apresentará apenas 

“Airbus_WorldDEM4Ortho_24m”. 

 

IMPORTANTE: Anotar o dado do Pixel Size: 24,74 metros será necessário para 

operação de declividade. 

 

A operação é necessária a fim de maximizar o processamento e minimizar o tempo gasto 

nas operações, visto que sem tal operação, muitas opções ficam atreladas a camada e, 

posteriormente, dificulta a operacionalização do uso da ferramenta de geoprocessamento 

declividade. 
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Figura 28: O Pop-up mostra os dados atrelados à camada Terrain e as Propriedades da Camada 

Terrain, o processo de definição de dados da camada 

 

Recortando Terrain – MDE 

 

É de extrema importância o recorte do Modelo Digital de Elevação para fins de 

processamento das operações no decorrer do projeto no ArcGIS PRO. 

O recorte não pode ser feito pela ferramenta Recortar/Clip, visto que é um Raster. 

Clica com o botão direito > Dados/Data > Export Raster/Export Raster.  

CONFIGURAÇÕES IMPORTANTES:  

1. Configurar o Sistema de Coordenadas para > 

SIRGAS_2000_UTM_25S  

2.  Recortar a Geometria > Recife  

3. Tamanho da Célula > X 25 e Y 25 (Por conta do Pixel Size)  

4. Valores de NoData > -99999 

Será gerada a camada Terrain_1.tif que iremos renomear como MDE – Recortado. 

Figura 29: “Recortando” o MDE - Exportando Raster pela opção Dados 
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Figura 30: Preenchendo os dados para a exportação do Raster e recorte do MDE. Dados 

importantes destacados. 

 

 

Figura 31: Após recortar o MDE, renomear e desmarcar o Terrain dos dados brutos a fim de 

visualizar o modelo recortado. 

 

 

Finalizado o recorte do Modelo Digital de Elevação, partiremos para o recorte das demais 

camadas que compõem o projeto. 
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Recorte das Camadas Drenagem e Cobertura e Uso da Terra. 

 

Para o recorte das camadas “Trecho de Drenagem” e “Uso e Ocupação do Solo” usamos 

a ferramenta Recortar. 

Ferramentas/Tools > Recortar/Clip (Ferramentas de Análise): Feições de Entrada 

ou Conjunto de Dados/Input Features or Dataset “O DADO A SER 

RECORTADO”, em Recortar Feições/Clip Features = “RECIFE”, em Feições de 

Saída/Output Features or Dataset aparecerá o endereço do arquivo que será gerado, 

conforme a figura 32 e figura 33. 

A operação é a mesma para ambas as camadas, visto que são de igual natureza.  

Figura 32: Opção Ferramentas 

 

Figura 33: Opção Recortar 

 

Figura 34: Recorte de uso e ocupação do solo 
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Figura 35: Recorte de uso e ocupação do solo 

 

 

Ao recortar todas as camadas e agrupar os dados brutos, anteriores aos recortados, 

desmarcar os dados brutos a fim de que apenas os recortados apareçam na tela do ArcGIS 

PRO, figura 34.  

Criar Camada de Centro Urbano   

Após cortar a camada, vamos classificar a mesma a fim de identificar todas as classes de 

uso do solo. 

Como para o projeto é necessário que o aterro esteja a 1 km de distância do maior centro 

urbano e a menos de 10 km, temos que identificar os centros urbanos, ou, na cada, 

mosaico de ocupação. 

Clica na camada com o botão direito do mouse > Simbologia/Symbology > 

Simbologia Primária/Primary Symbology > Opção Valores únicos > Esquema de 

Cores/Color scheme > Opção Classe. Figuras 34, 35 e 36. 

Figura 36: Etapa para identificação das classes de uso do solo 1 
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Figura 37: Etapa para identificação das classes de uso do solo 2 

 

 

Figura 38: Etapa para identificação das classes de uso do solo 3 

 

Após as etapas para a identificação das classes de uso do solo, vamos para as operações 

para a definição do centro urbano: 

Clique com o mouse direito em Propriedades/Properties > Consulta 

definições/Definition Query > Nova Consulta de Definição/New Definition Query > 

Selecionar todas as opções com “MOSAICO DE OCUPAÇÃO” com “ou” entre as 

opções> OK.  

Seleciona o Centro Urbano maior = Selecionar > Clique em “Listar por Seleção/Lis 

by Selection” e Desmarca a cidade de Recife > Clica no mosaico que representa o  

maior centro urbano > Lista por Ordem de Desenho/Lis by Drawing Order. 

Após esses passos, vamos exportar as feições e criar a camada de “Centro Urbano”. 

Clica com o botão direito do mouse na camada de Uso_terra recortada > Dados/Data 

> Exportar Feições/Export Features> Renomear como “Centro Urbano, figura 40. 
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Figura 39: Definindo as propriedades da camada para exportar feições. 

 

 

Figura 40:  Selecionando as classes “Mosaico de Ocupação” >  Seleciona toda a área superior 

clicando com a seta do mouse conforme mostra a área tracejada, selecionará todos  os quadrados 

superiores. 
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Figura 41: Clicando em “Lista por Ordem de Desenho” e exportando as feições e criando camada 

“Centro Urbano” 

 

Agrupar os recortes para fins de organização. 

Projetando as camadas 

Ir no GDB “Analise_multicritério.gdb”, clique com o botão direito em Novo/New > 

Criar Conjunto de Dados de Feição/Create Feature Dataset > Sistema de 

Coordenadas/ Coordinate System = “SIRGAS 2000 UTM ZONE 25S” > Nome do 

Conjunto = Dados_UTM > Executar. 

Após esses passos é possível reprojetar as suas Camadas. 

As camadas até então trabalhadas não estão no sistema de coordenadas correto, o sistema 

que deve ser usado para fins de cálculo preciso e de acordo com a verificação de 

adequação inicial, a UTM, necessitando que sejam adequadas e projetadas. O sistema de 

coordenadas projetado deve ser igual ao sistema de coordenadas do mapa principal. 

PROJETANDO PARA SIRGAS 2000 UTM ZONE 25S: 

Projetando as camadas na opção “Projetar” 

Figura 42: Opção Ferramentas 
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Figura 43: Pesquisar projetar em lote e preencher 

 

A ferramenta de Geoprocessamento Projetar será utilizada para os dados recortados 

“Centro Urbano”, "Trecho de Drenagem” e “Recife”. 

Ferramentas/Tools > Projetar em lote/Batch Project > Conjunto de Dados ou Classe 

de Feição de Entrada/Input Dataset or Feature Class = Os dados a serem projetado 

na coordenada UTM > Sistema de Coordenadas de Saída/Output Coordinate 

System = SIRGAS_200_UTM_ZONE_25S ( Coordenadas planas > UTM > South 

America > SIRGAS 2000 > SIRGAS 2000 UTM Zone 25S) > Àrea de trabalho de 

Saída e Conjunto de Dados de Modelo/Output Workspace and Template Dataset = 

Dados_UTM > Executar. 

Repetir o mesmo processo para as todas as camadas “Centro Urbano”, "Trecho de 

Drenagem” e “Recife”. 

Figura 44: Projetando para sistema de coordenadas UTM 
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Figura 45: Exemplo de operação de projeção para UTM concluída em uma das camadas 

 

 

Projetando as camadas na opção “Projetar Raster”: 

A ferramenta de Geoprocessamento Projetar será utilizada para os dados recortados do 

Modelo Digital de Elevação”. 

Ferramentas/Tools > Projetar Raster/Project Raster > Raster de Entrada/Input 

Raster = MDE - Recortado > Sistema de Coordenadas de Saida/ Output Coordinate 

System = SIRGAS_200_UTM_ZONE_25S ( Coordenadas planas > UTM > South 

America > SIRGAS 2000 > SIRGAS 2000 UTM Zone 25S) > Executar. 

Figura 46: Opção Projetar Raster 
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Figura 47: Exemplo de operação de projeção raster para UTM concluída em uma das camadas 

 

 

Figura 48: Agrupando os dados 

 

 

Agrupar os recortes projetados 

● Declividade 

Para o cálculo da declividade usamos o Modelo Digital de Elevação, MDE. 

Ferramentas > Declividade > Raster de Entrada = MDERecortado_ProgectRaster 

> OK. 
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Os dados vão ser processados automaticamente pela ferramenta. Para fins de adequação 

dos dados para posterior operações necessárias para as análises, vamos efetuar as 

operações a seguir. 

 

Figura 49: Ferramenta “Declividade” 

 

 

Figura 50: Processando os dados de declividade 
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Figura 51: Dados processados 

 

Após processamento dos dados clique com o botão direito do mouse 

Simbologia/Symbology > Simbologia primária/Primary symbology = Classificar > 

Classes/Classes = 5 > Esquema de cores/Color scheme  = figura 52. 

Figura 52: Tratamento dos dados na opção simbologia 

  

 

 



 

128 
 

Figura 53: Mapa após cálculo de declividade e com a alteração da simbologia 

 

 

● Distância Euclidiana – Trecho de Drenagem e Centro Urbano 

A Distância Euclidiana, é necessário medir a distância dos trechos de drenagem e do 

centro urbano, pois, para o projeto inicial, há especificidades de localização dos aterros 

em relação aos trechos de drenagem, rios, e do centro urbano. Assim, usamos a 

ferramenta, Distância Euclidiana para fins de medição.  

 

Figura 54:  Ferramenta distância Euclidiana indicada por seta vermelha 
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Figura 55: Cálculo da distância dos trechos de drenagem 

 

Figura 56: Opção “Ambiente” – Seleção Recife 

 

Ferramentas/Tools > Distância Euclidiana/Euclidean Distance > Dados Fonte do 

Raster ou Feição de entrada/Input Raster or feature source data = 

“RededeDrenagemrecort_Project1. Ir para a aba Ambientes/Environments > 

Selecionar a Máscara/Mask = Recife e Extensão/Extent = Extensão de Visualização 

Atual/Current Display Extent > Executar. 

 

OBS: TRECHOS DE DRENAGEM E REDE DE DRENAGEM ESTÃO, NO 

PRESENTE PROJETO, COM O MESMO SIGNIFICADO. 
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Figura 57: Opção “Extensão” – Extensão de Visualização Atual 

 

Figura 58: Execução da operação

 

 

A operação é feita para ambos os dados, Centro Urbano e Rede/Trecho de 

Drenagem, da mesma forma que exemplificado, apenas modificando os dados. 

OBS: Ajustar os dados após os cálculos de distância. Clicar no botão direito do mouse > 

Simbologia/Symbology > Simbologia Primária/Primary symbology = Classificar > 

Classes/Classes =  5 > Esquema de Cores/Color scheme igual o da figura 59. Renomear 

camada e agrupar como processados. Para os Trechos/Rede de Drenagem, é necessário a 

inversão de valores, na opção “Mais” conforme indicado na seta da figura 59, pois os 

aterros precisam ficar a uma distância de no mínimo 300 metros. 

OBS: A CAMADA RECIFE USADA NAS OPÇÕES “MÁSCARA” É SEMPRE A 

PROJETADA. 
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Figura 59: Simbologia dos dados de Trecho\Rede de Drenagem 1 

 

Figura 60: Simbologia dos dados de Trecho\Rede de Drenagem 2. Com os campos corretos 

 

Figura 61: Dados Processados 
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Reclassificação 

 

A reclassificação é uma etapa necessária antes da etapa de sobreposição dos dados, que 

será feita posteriormente, para a análise por múltiplos critérios, visto que os dados 

possuem grandezas diferentes e necessitam ser reclassificados para fins de 

sobreposição. Nos próximos passos serão utilizados as legendas em português do 

programa, a fim de facilitar a compreensão do aluno/leitor.  

As camadas reclassificadas precisarão de ajustes nas simbologias, conforme figura 

68. Modificar a Faixa de Cores. Os melhores dados são os de peso 5 e os piores de 

peso 1. 

OBS: Seguir as faixas nas imagens, visto que se trata de especificações do projeto 

inicial – ATENÇÃO. 

Figura 62: Ferramenta “Reclassificar” 

 

Ferramentas > Reclassificar( Fig.60) > Arquivo a ser Reclassificado > Ir na aba 

Ambientes > Máscara = Recife > Extensão = Extensão de Visualização Atual > 

Voltar para Parâmetros > Classificar > modificar as faixas conforme orientações 

nas figuras em referência a cada camada (Fig.63 a Fig 69). 

Figura 63: Processamento da ferramenta “Reclassificar” com os dados de Declividade 
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OBS: Observar as faixas de valores nas imagens de acordo com os parâmetros 

informados para cada projeto solicitado na ocasião, pois os detalhes das delimitações 

são de extrema importância no resultado. Mas primeiro vamos em ambientes. 

Figura 64: Configurações da aba Ambientes 1 

 

 

OBS: Observar o preenchimento correto de todos os campos conforme a figura 62 e 

as subsequentes. 

Figura 65 Configurações da aba Ambientes 2 
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Figura 66: Configurações da aba Ambientes 3 

 

Figura 67: Classificando os dados por faixas - Declividade 

 

 

 

Clique em Classificar, abrirá uma janela a fim de preenchimento. 
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Figura 68: Classificando os dados por faixas – Declividade 2 

  

 

A Figura 66 mostra o quadro que aparecerá após o aluno clicar em classificar. Onde será 

necessário ele preencher as classes em referência aos valores preenchidos anteriormente 

e em consonância com o projeto proposto. No presente projeto estabelecemos os valores 

de referência apresentados na Figura 69. 

Figura 69: Classificando os dados de declividade 

  

 

Na Figura 70 – observar as faixas de valores iniciais e finais e suas classes de 1 a 5, de 

acordo com as melhores e piores classificações consideradas pelo que informa o 

enunciado. Os valores preenchidos tomam como base uma padronização a fim de 

reclassificar e posteriormente usar tais valores para a ponderação. Na etapa anterior foram 

definidas as classes. Tem que preencher toda a tabela novamente antes de clicar em 

executar, a fim de não cometer erros. DICA, pois se todos os passos não forem feito, o 

ArcGIS fechará e não executará. 
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Figura 70: Dados de Declividade Processados 

 

Após o processamento dos dados, ir em simbologia para fins dos ajustes em relação às 

cores, usar as escalas de verde e vermelho. 

Figura 71: Modificando a Simbologia dos Dados de Declividade. 
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Figura 72: Reclassificando dados de Drenagem

 

 

OBS: Repetir todos os passos anteriores com atenção, realizar os preenchimentos nas 

abas ambientes, preencher com atenção a abra que será aberta após clicar em classificar 

e preencher com atenção os valores novos iniciais e finais e suas classes (NOVO) antes 

de executar, pois se todos os passos não forem feitos, o ArcGIS fechará e não executará. 

Figura 73: Reclassificando os dados de Drenagem 2 

 

 

DICA: Tem que preencher toda a tabela novamente antes de clicar em executar, a fim de 

não dar erro. 
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Figura 74:– Reclassificando os dados de Centro Urbano 

 

Figura 75: Reclassificando os dados de Centro Urbano 2 

 

Figura 76:  Reclassificando os dados de Centro Urbano 3 
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Figura 77: Dados Reclassificados 

 

 

Sobreposição Ponderada 

Após a reclassificação dos valores, vamos para a operação final na construção do mapa 

de localização da área “ótima” para a construção do aterro sanitário em Recife. É 

necessário sobrepor os dados a fim que, com cada peso adequado a camada, seja feita a 

análise pelo ArcGIS.  

Ferramentas > Sobreposição Ponderada > Incluir as Camadas “Declividade – 40%”, 

“Trecho de Drenagem – 35%” e “Centro Urbano” – 25 % e colocar os pesos 

adequados > Escalas = 1 – 5 > Clicar em cada camada e ajustar a tabela de 

remapeamento das camadas > Executar. 

Ajustando a tabela de remapeamento das camadas: Dentro de cada camada na 

sobreposição, selecionar “restrito” para as categorias que não podem ser consideradas de 

acordo com as especificações do projeto: 

Declividade > Peso 1 = Restrito 

Trecho de Drenagem > Peso 2 = Restrito 

Centro Urbano > Pesos 1 e 2 Restritos. 

ATENÇÃO: Ajustar os pesos restantes e igualar as pessoas da primeira coluna iguais ao 

da segunda coluna, visto que quando há modificação para restrito, pode desconfigurar os 

demais pesos. Conferir antes de executar. 

Após as configurações, executar  
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Figura 78: Operação de sobreposição ponderada dos dados 

 

Ferramentas > Sobreposição Ponderada > Preencher com todas as bases de dados 

que foram reclassificadas e serão usadas na sobreposição ponderada (Figura 76). 

 

Figura 79: Incluindo os Dados Reclassificados na ordem declividade, Trecho de Drenagem e Centro 

Urbano 
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Figura 80: Estabelecendo os graus de influência das camadas a serem sobrepostas 

 

 

As Figuras 80 e 81 exemplificam a proposta do projeto, com o preenchimento do grau 

de influência de cada fator (base de dados tratada) na composição da sobreposição 

ponderada, pois o enunciado estabelece os parâmetros claramente o norteia todo o 

presente projeto, desde as buscas nas bases de dados secundárias até os preenchimentos 

e usos das ferramentas disponibilizadas no ArcGIS. 

Declividade – 40%, Trecho de Drenagem – 35% e Centro urbano 25 % na escolha 

da alocação do aterro sanitário. 

Atenção para os parâmetros e para as escalas conforme exemplificado na figura 77. 

Figura 81: Restritos em Declividade de acordo com o enunciado inicial – remapeamento de camada  
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Figura 82: Operação de sobreposição e análise com vários critérios finalizada 

 

Ajustar a simbologia para fins de produção do layout final. 

Simbologia > Modificar Esquema de cores > As camadas 1 e dois sem preenchimento 

> ajustar as camadas 3, 4 e 5 com as legendas de acordo com a figura 83 e 84 > 

Fechar. 

Adicionar o mapa base = Imagem 

Para fins de produção do layout final > Inserir do menu de ferramentas > Novo 

Layout > escolher configuração do layout. 

No Layout > Inserir do menu de ferramentas > Estrutura de Mapa e selecionar o 

mapa > Desenhar o mapa na página > Na opção inserir do menu de ferramentas > 

Incluir os itens básicos para o layout do mapa como: 

1. Legenda; 

2. Grade – Clica em cima do mapa desenhado; 

3. Texto Dinâmico com referência espacial do mapa; 

4. Barra de escala; 

5. Seta. 

Figura 83 – Ajustes em Simbologia e Legenda 
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Figura 84 – Inclusão do mapa base > Imagem 

 

Figura 85: Mapa Base incluído 
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Figura 86: Itens básicos do mapa – barra de ferramentas 

 

Para exportar o Layout Final vá na aba Compartilhar > Exportar Layout > Escolher 

PDF ou JPGE > Nome > Escolher pasta e nomear arquivo > Ok > Exportar 

Figura 87:  Layout final do mapa de análise multicritério 

 

 

Finalizamos a produção do nosso mapa! 

Não esqueça!! Antes de fechar o ArcGIS Pro você deve salvar o projeto! 


